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TUYÊN BỐ BẢN QUYỀN 

Tài liệu này thuộc loại sách giáo trình nên các nguồn thông tin có thể được 

phép dùng nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo.  

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh 

thiếu lành mạnh sẽ bị nghiêm cấm. 
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LỜI NÓI ĐẦU 

Adobe Photoshop CS6 là một phần mềm xử lý ảnh (image-processing 

software) chuyên nghiệp. Photoshop cho phép người sử dụng chỉnh sửa ảnh 

(retouching), ghép ảnh (composing), phục chế ảnh (restoration), tô màu tranh ảnh 

(painting)… một cách dễ dàng và hiệu quả.  

Phần mềm này là một công cụ không thể thiếu của các nhiếp ảnh gia, các nhà 

thiết kế đồ hoạ, thiết kế web và biên tập video. 

Ngoài ra Adobe Photoshop CS4 còn phối hợp rất tốt với các phần mềm khác 

của hãng Adobe như: 

− Phần mềm vẽ trang trí và minh họa (illustration software) Adobe Illustrator 

CS6. 

− Phần mềm sắp chữ và trình bày (typesetting and layout software) Adobe 

InDesign CS6. 

− Phần mềm tạo hình ảnh động (animation software) Adobe Flash CS6. 

− Phần mềm thiết kế trang web (web design software) Adobe Dreamweaver 

CS6. 
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GIÁO TRÌNH MÔ ĐUN 

Tên mô đun: ĐỒ HỌA ỨNG DỤNG 2 (ADOBE PHOTOSHOP) 

Mã mô đun: MĐ18 

VỊ TRÍ, TÍNH CHẤT CỦA MÔ ĐUN: 

1. Vị trí:  

− Mô đun được bố trí giảng dạy sau các môn chung, môn cơ sở ngành và mô 

đun Đồ họa ứng dụng 1 

2. Tính chất: 

− Mô đun đồ họa ứng dụng 2 (Adobe Photoshop) là mô đun thuộc nhóm các 

mô đun chuyên môn nghề. 

MỤC TIÊU MÔ ĐUN: 

1. Về kiến thức: 

− Liệt kê các thành phần trong môi trường của phần mềm Photoshop; 

− Phân biệt các chế độ màu thường sử dụng trong quá trình xử lý ảnh; 

− Liệt kê các công cụ áp dụng để tách ghép hình ảnh, điều chỉnh màu sắc; 

− Nêu chức năng của layer mặt nạ, liệt kê các trường hợp áp dụng hiệu ứng mặt 

nạ cho ảnh; 

− Nêu chức năng các bộ lọc trong Photoshop; 

2. Về kỹ năng: 

− Sử dụng thành thạo các công cụ trong Photoshop; 

− Làm việc thành thạo trên lớp (layer); 

− Chỉnh sửa được ảnh, điều chỉnh màu sắc tùy ý; 

− Phục hồi được ảnh cũ, nhàu, ố; 

− Tạo hiệu ứng cho bức ảnh, lồng ghép khung ảnh nghệ thuật; 

− Chèn chữ nghệ thuật vào trong bức ảnh; 

− Xuất ảnh với nhiều định dạng khác nhau; 

− In ảnh với màu sắc trung thực; 

3. Về năng lực tự chủ và trách nhiệm: 
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− Có khả năng tự nghiên cứu, tự học, tham khảo tài liệu liên quan đến môn học để 

vận dụng vào hoạt động hoc tập. 

− Vận dụng được các kiến thức tự nghiên cứu, học tập và kiến thức, kỹ năng đã 

được học để hoàn thiện các kỹ năng liên quan đến môn học một cách khoa học, 

đúng quy định.  

NỘI DUNG MÔ ĐUN 
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BÀI 1: LÀM QUEN VỚI MÔI TRƯỜNG LÀM VIỆC CỦA PHOTOSHOP 

Mã bài: MĐ18_01 

GIỚI THIỆU 

Bài này giới thiệu cho bạn khái niệm về các loại ảnh, kênh màu, hướng dẫn tạo 

File, lưu trữ và các thao tác cơ bản xuất File. 

MỤC TIÊU 

− Trình bày các khái niệm cơ bản trong Photoshop; 

− Trình bày các thanh công cụ của Photoshop; 

− Sử dụng được các công cụ thông dụng trong Photoshop; 

− Làm biến dạng hình ảnh tùy ý; 

− Rèn luyện tính chính xác, sáng tạo, linh hoạt. 

NỘI DUNG CHÍNH 

1 CÁC KHÁI NIỆM TRONG PHOTOSHOP 

1.1 Độ phân giải của hình ảnh 

Độ phân giải của hình ảnh là số điểm ảnh trong 1 inch, thường tính bằng 

pixels/inch. So sánh độ phân giải của 2 tập tin ảnh bằng cách đếm số lượng điểm 

ảnh trong 1 inch, tập tin nào có số điểm ảnh lớn hơn thì độ phân giải cao hơn, ảnh 

rõ nét hơn. 

1.2 Các chế độ hiển thị hình ảnh 

1.2.1 Bitmap 

Là hình ảnh mà mỗi điểm ảnh được lưu trữ bằng 1 bit. Như vậy mỗi điểm ảnh 

của hình ảnh bitmap chỉ có thể là điểm đen hoặc điểm trắng. Do đó, hình ảnh dạng 

bitmap chỉ có 2 sắc độ xám (2 gray levels). 

Hình ảnh bitmap thường được gọi là ảnh nét. 

Một hình ảnh khổ A4 (8.26 inch x 11.69 inch) với độ phân giải ảnh 300 ppi, 

nếu được lưu trữ dưới chế độ bitmap sẽ có dung lượng file là: 

8.26 x 300 x 11.69 x 300 x 1bit = 8.690.346 bit = 1.086.293 bytes = 1.03 MB 
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1.2.2 Grayscale 

Là hình ảnh mà mỗi điểm ảnh được lưu trữ bằng 8 bit. Như vậy mỗi điểm ảnh 

của hình ảnh grayscale có thể nhận một giá trị từ 0 đến 255. Do đó, hình ảnh dạng 

grayscale có 256 sắc độ xám (tức 2
8
). 

Những ảnh đen trắng (black and white photograph) mà chúng ta thường thấy 

trên báo chí có chế độ hình ảnh là grayscale. 

Một hình ảnh khổ A4 với độ phân giải ảnh 300 ppi, nếu được lưu trữ dưới chế 

độ grayscale sẽ có dung lượng file là: 

1.03 MB x 8 = 8.24 MB 

 

1.2.3 RGB Color 

Là hình ảnh mà mỗi điểm ảnh được lưu trữ bằng 24 bits: 8 bits cho màu đỏ 

(Red), 8 bits cho màu lục (Green), 8 bits cho màu lam (Blue). Như vậy mỗi điểm 

ảnh của hình ảnh RGB có thể nhận một giá trị từ 0 đến 16.777.216. Do đó, hình 

ảnh dạng RGB có thể có đến 16,7 triệu màu (tức 2
24

). 
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Những ảnh chụp màu (color photograph) từ máy ảnh kỹ thuật số có chế độ hình 

ảnh là RGB. 

Một hình ảnh khổ A4 với độ phân giải ảnh 300 ppi, nếu được lưu trữ dưới chế 

độ RGB sẽ có dung lượng file là: 

1.03 MB x 24 = 24.72 MB 

Nếu chọn Windows > Channels để hiển thị Channels panel, bạn sẽ thấy hình 

ảnh RGB có 3 kênh màu R, G, B: 

 

Hình ảnh RGB thường được sử dụng khi thiết kế trang web, rửa ảnh kỹ thuật 

số, trình chiếu, xử lý video… 

1.2.4 CMYK Color 

Để sử dụng trong in ấn công nghiệp, hình ảnh màu cần được chuyển sang chế 

độ CMYK (Cyan, Magenta, Yellow, Black) bằng cách chọn Image > Mode > 

CMYK color. 

Mỗi điểm ảnh của hình ảnh dạng CMYK được lưu trữ bằng 32 bits: 8 bits cho 

màu lam lục (Cyan), 8 bits cho màu đỏ cánh sen (Magenta), 8 bits cho màu vàng 

(Yellow) và 8 bits cho màu đen (Black). 

Một hình ảnh khổ A4 với độ phân giải ảnh 300 ppi, nếu được lưu trữ dưới chế 

độ CMYK sẽ có dung lượng file là: 

1.03 MB x 32 = 32.96 MB 
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2 CÁC KÊNH MÀU 

2.1 Hệ màu 

2.1.1 Hệ màu trong Photoshop: Bitmap 

− Hệ màu này cho ta hình ảnh chỉ thuần màu đen và trắng; Không có bất kì một 

sắc độ nào khác. Khi phóng to hình lên chúng ta sẽ thấy hình ảnh chỉ được tạo 

bởi những chấm đen và trắng. 

− Trong ảnh bitmap: Những Options sửa chữa của photoshop không thể thực hiện 

được. Như vậy nó phải được chỉnh sửa từ khi ảnh còn là grayscale. Ảnh bitmap 

có dung lượng nhỏ gấp nhiều lần các mode ảnh khác. 

− Mode bitmap được sử dụng trong xuất film cho các kỹ thuật in công nghiệp 

(Offset, Helio,…). 

2.1.2 Hệ màu Grayscale 

− Grayscale là hệ màu trong photoshop sử dụng 256 sắc độ xám của hình ảnh. Tất 

cả các màu sắc đều được chuyển về trắng, đen, xám, độ đậm nhạt của màu xám 

phụ thuộc vào độ đậm nhạt của màu nguyên thủy. Với hệ màu Grayscale, màu 

xám chiếm diện tích nhiều hơn trắng và đen. 
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− Ảnh Gray được sử dụng trong nhiếp ảnh ngày xưa. Hiện tại vẫn được sử dụng 

cho một số dạng ảnh nghệ thuật. 

2.1.3 Hệ màu Doutone Color 

− Hệ màu Duotone Color là bước chuyển tiếp của hệ màu Grayscale. Để sử dụng 

hệ màu này, chúng ta cần chuyển hình ảnh về Grayscale trước, sau đó vào menu 

Image > Mode > Duotone Color. Sau đó áp dụng lên hình ảnh 1,2,3 hoặc 4 tone 

màu khác nhau. Kết quả cho ta hình ảnh gồm 1 màu bất kì và màu đen. 

− Duotone ( bao gồm cả triotone và quadtone ) là: một chế độ màu rất chuyên 

biệt; Chỉ dành cho việc in thưong mại, vốn sử dụng hai, 3 hay 4 màu mực trải 

rộng ra khắp ảnh. 

2.1.4 Hệ màu trong photoshop cho hình ảnh 8 bit với 256 màu sắc – Indexed 

Color 

− Hệ màu Indexed cho ta hình ảnh 8 bit với 256 màu sắc. Do là hình 8 bit nên độ 

chuyển màu của hình ảnh sẽ không được mịn. Với hình ảnh hệ Indexed: Những 

vùng có điểm ảnh gần giống nhau sẽ được tự động gộp lại chung thành 1 mảng. 

Nên khi phóng to hình ảnh lên, chúng ta sẽ nhìn rõ từng mảng màu riêng biệt. 

− Chế độ Indexed Color dành cho web. Bạn lưu các ảnh GIF và PNG -8 trong 

Indexed Color. Nhưng chỉ các dạng file đó là cần 1 số lựong màu như vậy. Điều 

đó giúp giảm kích cở file , giảm lượng khoảng trống mà ảnh đòi hỏi trên web 

server của bạn. Đồng thời tăng nhanh thời gian tải xuống 

2.1.5 Hệ màu RBG Color 

− Hệ màu RBG là: Một hệ màu phổ biến, được tạo bởi 3 màu chính Red, Green, 

Blue. Giá trị các màu của hệ RBG dao động từ 0 đến 255. Màu thuần đen khi 

tất cả các giá trị bằng 0; Thuần trắng khi tất cả các giá trị bằng 255. RGB là một 

chế độ màu phụ gia – Nghĩa là bạn thêm càng nhiều lượng màu của mổi thành 

phần thì: Bạn càng tiến đến màu trắng . 
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− Đây là một hệ màu được sử dụng  cho những hình ảnh đươc dùng để hiển thị 

trên màn hình; Hoặc để rửa ảnh ở phòng lab. Để sử dụng ảnh RGB trong in ấn; 

Bạn cần chuyển hệ màu RGB sang CMYK trong photoshop. 

2.1.6 Hệ màu CMYK trong photoshop 

 

− CMYK cũng là một hệ màu trong photoshop phổ biến. Được tạo bởi những 

màu gốc à Cyan, Magenta, Yellow, Black. Người ta sử dụng ký tự K thay cho 

màu đen vì kí tự B tương ứng với Blue (xanh da trời). Đây là hệ màu sử dụng 

rộng rãi trong in ấn. 4 màu gốc của CMYK tương ứng với 4 màu của hộp mực 

máy in. Giá trị từng màu của CMYK dao động từ 0 đến 100%. Màu thuần trắng 

khi tất cả các giá trị bằng 0; Thuần đen khi tất cả các giá trị bằng 100%. 

− CMYK là một chế độ màu khử – nghĩa là: Lượng màu của mổi thành phần càng 

íi thì bạn càng tiến đến màu trắng. 

2.1.7 Hệ màu Lab Color 

 

− Hệ màu Lab giúp ta phân cách hình ảnh ra ánh sáng và màu sắc riêng biệt. Ở hệ 

màu Lab chúng ta sử dụng bảng Channels ( menu Window > Channels) để thao 

tác. Lab cho ta 3 channels: 
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+ Lightness: chứa những vùng sáng tối của hình ảnh. 

+ Kênh a: những vùng có màu green và red của hình ảnh. 

+ Kênh b: những vùng có màu blue và yellow cảu hình ảnh. 

− Bạn không nên in các ảnh LAB trên một máy in phun mực hoặc upload chúng 

lên web site của bạn. Bạn nên chuyển đổi các ảnh RGB hay CMYK của bạn 

sang chế độ LAB; Trước khi sử dụng một trong các bộ lọc: Sharpen của 

Photoshop. Hãy áp dụng bộ lọc Unsharp Mask. Sử dụng lệnh Edit > Fade 

Unsharp Mask , và thay đổi chế độ hòa trộn từ Normal sang Lunilosity. Cùng 

một kết quả , nhưng tác vụ được thực hiện ít hơn. Đồng thời hả năng làm giảm 

chất lượng ảnh cũng thấp hơn 

2.1.8 Hệ màu Multichannel Color 

− Multichannel là một hệ màu trong photoshop rất đặc biệt. Nó thể hiện 256 cấp 

độ xám ở mỗi kênh. Tuy nhiên, với hệ màu này, tất cả các layers sẽ bị flatten ( 

gộp  lại làm 1). Đồng thời chúng ta không được phép sử dụng layer trong hệ 

này. 

− Giống như Duotone; Multichannel là 1 chế độ màu chỉ dùng giới hạn trong các 

máy in thương mại. Bởi vì nó phụ thuộc vào các màu mực đã được pha trộn sẳn 

để áp lên giấy. 

− Bạn có thể cần chế độ Multichannel khi tạo 1 logo cho khách hàng 

2.2 Chanel Palette 
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Chanel pelette là cửa sổ hiển thị các kênh màu được phân tích từ hệ màu bạn 

chọn khi tạo File. 

Thường mình làm việc với 2 hệ màu RGB, CMYK 

 

         

 

2.3 Lệnh trộn kênh 

Tính năng này cho phép bạn sửa chữa channel và tạo ra hình ảnh màu xám từ 

các hình ảnh màu.  

Chỉ cần tạo một bản sao lưu của một hình ảnh trước khi thực hiện trộn. Sau đó 

làm theo các bước sau: 

− Chọn channel tổng hợp trong bảng điều khiển Channel. 

− Chọn Image → Adjustments → Channel Mixer. Channel Mixer hộp thoại sẽ 

xuất hiện. 

− Preset : màu pha trộn 

− Đối với Output Channel, chọn 

− Kéo thanh trượt bất kỳ để tăng/ giảm từng kênh màu của channel đầu ra  

− Nhấn OK để thoát khỏi Mixer Channel. 

Lưu ý: 

Nếu bạn muốn chuyển hình trắng đen, sau khi bạn thoát khỏi Mixer Channel, 

chọn Image→Mode→Grayscale để hoàn thành việc chuyển đổi. 
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3 GIAO DIỆN CHƯƠNG TRÌNH 

3.1 Tạo tập tin mới 

− Khởi động phần mềm  

− Chọn File/ New 

 

Xác định kích thước, độ phân giải, hệ màu sử dụng, màu nền  

3.2 Lưu tập tin mới 

− File/ Save 

− File name: đặt tên 

https://hocphotoshop.vn/wp-content/uploads/2015/09/Channel-Mixer-trong-Adjustment-1.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/09/Channel-Mixer-trong-Adjustment-1.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/09/Channel-Mixer-trong-Adjustment-1.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/09/Channel-Mixer-trong-Adjustment-1.jpg
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− Format 

+ Định dạng mặc đinh lưu File Photoshop : *.psd 

+ Lưu dạng File hình ảnh: *.gif, *. Jpeg, *.png 

3.3 Màn hình làm việc 

1. Thanh menu: Chứa các menu lệnh làm việc của chương trình 

2. Thanh đặc tính: Chứa các tính chất, các tùy chọn của đối tượng hay công cụ 

được chọn. 

3. Thanh tiêu đề: Chứa tên tài liệu hiện hành, tỷ lệ thu phóng, hệ màu và chức 

năng phóng to, thu nhỏ, đóng chương trình. 

4. Thanh công cụ: Chứa các công cụ làm việc trực tiếp của chương trình. 

5. Các Palette lệnh: Mỗi Palette lệnh sẽ chứa một nhóm lệnh 

6. Palette quản lí các lớp (layer) của file đang thao tác.  

Ngoài ra, còn có Vùng làm việc chứa thanh trượt, thước và các thành phần hỗ 

trợ khác. 

 

3.4 Hiển thị các thành phần trên màn hình 

− Menu Window/ Chọn tên thanh công cụ (Pattele) 

2 

1 

3 

4 

5 

6 
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3.5 Thiết lập màn hình 

− Menu View/ Screen mode: các chế độ xem 

− Extras : hiển thị các công cụ hổ trợ (Lưới, đường gióng,..) 

− Show/ Grid: lưới; / Guides: đường gióng; 

− Snap to: chế độ bắt dính… 

3.6 Các công cụ thường dùng 



 

22 

 

4 XUẤT ẢNH VÀ IN ẤN 

4.1 Chọn không gian màu RGB 

 

− Trong phần giới thiệu các hệ màu thường dùng 

bạn đã được cung cấp khái niệm về các hệ màu. 

− Để chuyển đổi giữa các hệ màu bạn vào menu 

Image / Mode/ chọn hệ màu cần chuyển 

4.2 Xuất và in ấn 

− Để xuất File ảnh khi lưu bạn chọn phần Format ở các dạng sau: 

+ Định dạng mặc đinh lưu File Photoshop : *.psd 

+ Lưu dạng File hình ảnh: *.gif, *. Jpeg, *.png 

− Để xuất File đưa lên trang Web bạ chọn : 

+ File/ Save / Optimized  

+ Nút Ctrl–Alt–S. ImageReady lưu hình dựa  trên các thông số bạn nhập 

Nhóm công cụ chọn 

Nhóm công cụ vẽ hình, text 

Nhóm công cụ tô vẽ 

Nhóm công cụ hổ trợ 
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BÀI 2: CÁC LỆNH XỬ LÝ VÙNG CHỌN 

Mã bài: MĐ18_02 

GIỚI THIỆU 

Phần quan trọng nhất để làm việc với Photoshop là làm thế nào để chọn được 

một vùng chọn mà bạn cần xử lý. Khi một vùng chọn trên ảnh được chọn lựa thì 

chỉ phần đó chịu tác động, còn phần khác không bị ảnh hưởng. 

MỤC TIÊU 

− Trình bày chức năng các lệnh xử lý vùng chọn; 

− Trình bày các phương pháp tô màu; 

− Chọn được vùng tùy ý; 

− Sử dụng thành thạo các thao tác trên vùng chọn; 

− Tô được màu tiền cảnh và màu hậu cảnh; 

− Rèn luyện tính chính xác, cẩn thận, linh hoạt, sáng tạo. 

NỘI DUNG CHÍNH 

1 VÙNG LỰA CHỌN HÌNH HỌC 

  

1.1 Công cụ Rectangular Marquee 

  

− Tính chất: Chọn vùng hình ảnh theo dạng hình chữ nhật hay hình vuông. 

− Thao tác: 

+ Kết hợp nhấn giữ phím Shift trên bàn phím để vẽ vùng chọn hình vuông. 

+ Kết hợp nhấn giữ phím Alt để tạo vùng chọn từ tâm. 

+ Alt + Shift + Rê chuột: Tạo vùng chọn hình vuông từ tâm. 

− Kết quả: Một khung viền nhấp nháy. Mọi thao tác xử lý lúc này chỉ có tác dụng 

bên trong khung viền đó. 

− Thuộc tính công cụ 

http://homasg.com/wp-content/uploads/2015/02/PTS_010.png
http://homasg.com/wp-content/uploads/2015/02/PTS_011.png
http://homasg.com/wp-content/uploads/2015/02/PTS_010.png
http://homasg.com/wp-content/uploads/2015/02/PTS_011.png
http://homasg.com/wp-content/uploads/2015/02/PTS_010.png
http://homasg.com/wp-content/uploads/2015/02/PTS_011.png
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1. New Selection : Tạo vùng chọn mới 

2. Add to Selection: Thêm vùng chọn 

3. Subtract from Selection : Giảm bớt vùng chọn 

4. Intersect with Selection: Vùng chọn tạo ra là phần giao nhau giữa vùng chọn 

cũ và mới. 

5. Feather (Shift + F6): Độ nhòe biên.  

6. Anti-alias: giảm độ răng cưa của biên 

7. Style:  

+ Normal: Bình thường – tuỳ ý 

+ Fixed ratio: theo tỷ lệ cố định (ví dụ chiều dài gấp đôi chiều cao hoặc ngược 

lại, có mũi tên chuyển đổi qua lại) 

+ Fixed Size: theo kích thước cố định (cho trước thông số chiều dài và chiều 

cao của vùng chọn, có mũi tên chuyển đổi qua lại) 

8. Width/ Height: kích thước vùng chọn 

9. Refine Edge 

 + Radius: Cải thiện phần biên vùng chọn, 

giúp cho phần biên được êm hơn và gần 

sạch hơn 

+ Smooth: Bo tròn các góc nhọn 

+ Feather: Tạo độ nhòe biên 

+ Contrast: Độ tương phản (độ sắc nét) tại 

biên vùng chọn. 

+ Shift Edge: Thu hẹp / nới rộng vùng 

chọn. 

1 2 3 4 5 7 8 9 6 
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+ Output to: Có một số tùy chọn  

o Xuất ra thành vùng chọn  (Selection) 

o New layer 

o Layer mask 

o Document…  

o New layer with layer mask 

+ Remember Settings: Lưu lại các thông 

số cho lần sử dụng tiếp theo 

1.2 Công cụ Eliptical Marquee 

  

− Tính chất: Chọn vùng hình ảnh theo dạng hình elip hay hình tròn. 

− Thao tác và thuộc tính: Tương tự công cụ Rectangular Marquee. 

1.3 Công cụ Single row Marquee 

 

− Tạo vùng chọn một dòng ngang 1 pixel. Điều kiện: Feather = 0 

1.4 Công cụ Single column Marquee 

 

− Tạo vùng chọn một cột dọc 1 pixel. Điều kiện: Feather = 0. 

2 VÙNG LỰA CHỌN TỰ DO 

  

2.1 Công cụ Lasso 

 

− Tính chất: Công cụ chọn vùng tự do 

− Thao tác: 

http://homasg.com/wp-content/uploads/2015/02/PTS_012.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/03/PTS_020.png
http://homasg.com/wp-content/uploads/2015/03/PTS_021.png
http://homasg.com/wp-content/uploads/2015/02/PTS_012.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/03/PTS_020.png
http://homasg.com/wp-content/uploads/2015/03/PTS_021.png
http://homasg.com/wp-content/uploads/2015/02/PTS_012.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/03/PTS_020.png
http://homasg.com/wp-content/uploads/2015/03/PTS_021.png
http://homasg.com/wp-content/uploads/2015/02/PTS_012.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/03/PTS_020.png
http://homasg.com/wp-content/uploads/2015/03/PTS_021.png
http://homasg.com/wp-content/uploads/2015/02/PTS_012.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/03/PTS_020.png
http://homasg.com/wp-content/uploads/2015/03/PTS_021.png
http://homasg.com/wp-content/uploads/2015/02/PTS_012.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/03/PTS_020.png
http://homasg.com/wp-content/uploads/2015/03/PTS_021.png
http://homasg.com/wp-content/uploads/2015/02/PTS_012.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/02/PTS_018.png
http://homasg.com/wp-content/uploads/2015/03/PTS_020.png
http://homasg.com/wp-content/uploads/2015/03/PTS_021.png
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+ Chọn công cụ Lasso. 

+ Nhấn giữ và kéo rê chuột sao cho đường viền chọn chạy theo chu vi của một 

đối tượng. Muốn kết thúc thao tác chọn, chỉ cần nhả chuột. 

− Kết quả: Đường viền chọn bao quanh đối tượng theo đường chu vi. 

2.2 Công cụ Polygonsal Lasso 

 

− Tính chất: Công cụ chọn vùng chọn tự do. 

− Thao tác: 

+ Click từng điểm để tạo khung viền chọn. 

+ Click lại điểm đầu tiên hoặc Click kép để kết thúc. 

+ Xóa điểm bằng phím Delete. 

2.3 Công cụ Magnetic Lasso 

 

− Tính chất: Công cụ Lasso từ tính. Khi thao tác với công cụ này thì vùng chọn 

luôn bám vào biên của hình ảnh, thích hợp cho những đối tượng có độ tương 

phản cao về màu sắc giữa biên đối tượng với nền. 

− Thao tác: 

+ Click xác định điểm đầu tiên, nhả chuột, rê chuột dọc biên đối tượng, click 

lại điểm đầu tiên hoặc click kép để kết thúc. 

+ Trong quá trình di chuyển chuột quanh chu vi đối tượng, có thể click để định 

hướng vùng chọn đi đúng hướng (nếu chế độ tự động không chính xác). 

+ Xóa điểm chọn sai bằng phím Delete. 

3 VÙNG LỰA CHỌN DỰA TRÊN MÀU SẮC  

 

3.1 Công cụ Magic Wand 

 

− Tính chất: Là công cụ chọn vùng theo vùng màu tương đồng. 

http://homasg.com/wp-content/uploads/2015/03/PTS_022.png
http://homasg.com/wp-content/uploads/2015/03/PTS_023.png
http://homasg.com/wp-content/uploads/2015/03/PTS_024.png
http://homasg.com/wp-content/uploads/2015/03/PTS_022.png
http://homasg.com/wp-content/uploads/2015/03/PTS_023.png
http://homasg.com/wp-content/uploads/2015/03/PTS_024.png
http://homasg.com/wp-content/uploads/2015/03/PTS_022.png
http://homasg.com/wp-content/uploads/2015/03/PTS_023.png
http://homasg.com/wp-content/uploads/2015/03/PTS_024.png
http://homasg.com/wp-content/uploads/2015/03/PTS_022.png
http://homasg.com/wp-content/uploads/2015/03/PTS_023.png
http://homasg.com/wp-content/uploads/2015/03/PTS_024.png
http://homasg.com/wp-content/uploads/2015/03/PTS_022.png
http://homasg.com/wp-content/uploads/2015/03/PTS_023.png
http://homasg.com/wp-content/uploads/2015/03/PTS_024.png
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− Thao tác: 

+ Chọn công cụ Magic wand. 

+ Click vào một màu trên hình ảnh, một vùng màu tương ứng được chọn. Độ 

rộng của vùng chọn tùy thuộc vào giá trị Tolerance trên thanh Options. 

− Thuộc tính: 

 

+ Tolerance: Dung sai của vùng chọn, dung sai càng lớn thì vùng chọn càng 

rộng. 

+ Anti – Alias: Khử răng cưa 

+ Contiguous: Chọn màu cục bộ – màu được giới hạn bởi những vùng màu lân 

cận  

+ Use All Layers: Chọn trên tất cả các Layer, không phân biệt Layer hiện hành 

hay những Layer khác. 

+ Refine Edge (tương tự như đối với công cụ Marquee) 

3.2 Công cụ Quick Selection Tool 

 

Công cụ chọn nhanh một vùng chọn bằng cách nhấp chuột liên tục vào những 

vùng hình ảnh cần chọn. 

4 LÀM VIỆC VỚI VÙNG LỰA CHỌN 

4.1 Kết hợp các công cụ lựa chọn khác nhau trong khi làm việc 

Trong Photoshop việc chọn được vùng làm việc rất quan trọng vì khi chỉnh sửa 

hình, bạn chỉ tác động lên một phần của hình ảnh (Vùng chọn) chứ không tác động 

lên toàn hình ảnh. 

Khi chọn vùng làm việc bạn có thể dùng nhiều công cụ chọn lựa kết hợp với 

nhau bằng cách nhấn chọn công cụ và phím Shift để mở rộng thêm vùng chọn, 

phím Alt để gom vùng chọn. 

4.2 Tái đinh vị vùng lựa chọn 

− Lệnh Select All (Ctrl + A): Tạo vùng chọn bao kín toàn bộ hình ảnh. 

− Lệnh Deselect (Ctrl + D): Hủy vùng chọn. 

http://homasg.com/wp-content/uploads/2015/03/PTS_025.png
http://wp.me/p5G3rw-8z
http://wp.me/p5G3rw-8z
http://homasg.com/wp-content/uploads/2015/03/PTS_025.png
http://homasg.com/wp-content/uploads/2015/03/PTS_025.png
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− Lệnh Reselect (Ctrl + Shift + D): Lấy lại vùng chọn đã hủy. 

− Lệnh Inverse (Ctrl + Shift + I): Nghịch đảo vùng chọn.  

− Lệnh Grow: Nới rộng vùng chọn có vùng màu gần nhất (chọn màu cục bộ). 

− Lệnh Similar: Dò tìm trên toàn file tất cả các mẫu màu trùng với màu đã chọn 

ban đầu và chọn hết toàn file theo tông màu đã chọn. 

− Lệnh Transform Selection: Phóng to, thu nhỏ, xoay,…vùng chọn. Giữ Shift 

bấm vào một trong bốn nút vuông vùng chọn sẽ đều hơn (hoặc ta có thể click 

phải chuột vào bên trong vùng chọn để chọn chế độ Transform Selection). 
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BÀI 3: LÀM VIỆC VỚI LAYER  

Mã bài: MĐ18_03 

GIỚI THIỆU 

Trong photoshop bạn được làm quen với khái niệm về Layer, kỹ thuật hoà 

trộn các Layer với nhau để chỉnh sửa hình ảnh hay tạo ra cách hiệu ứng Blend màu 

đặc biệt. 

MỤC TIÊU 

− Trình bày các khái niệm lớp trong Photoshop; 

− Liệt kê và nêu chức năng các chế độ hòa trộn thường dùng; 

− Thao tác thành thạo trên lớp; 

− Sử dụng được các chế độ hòa trộn; 

NỘI DUNG CHÍNH 

1 LAYER 

1.1 Khái niệm 

Layers là những lớp trong suốt được đặt lên trên nền background. Các layers 

được xếp chồng lên nhau, và các bạn có thể nhìn thấy các lớp dưới tại những vị trí 

trong suốt (Transparent) hoặc nửa trong suốt (Semi-transparent) của layers. 

 

1.2 Phân loại 

− Background layer layers 

− Image layers 



 

30 

− Layer masks 

− Clipping masks 

− Layer groups 

− Layer effects 

− Smart Object 

− Adjusment layers 

− Shape layers 

− 3D layers 

− Video layer 

− Type  

1.3 Các layer thường gặp 

− Background layer: Là lớp nằm dưới cùng trong Palette Layer, có tên là 

Background và thường bị khóa. Bạn không thể tác động lên lớp nền. 

+ Bạn có thể nhấn Alt + Click đôi vào lớp nền để chuyển thành lớp bình 

thường 

− Image layers: Đây là loại layer mà chúng ta vẫn thường gặp nhất. Loại layer 

thông thường này được phát sinh trong những trường hợp sau: 

+ Khi bạn dùng công cụ Move  để dời một vùng chọn hoặc toàn bộ nội 

dung của hình ảnh A sang cửa sổ hình ảnh B thì trên hình ảnh B sẽ xuất hiện 

một layer mới. 

+ Khi bạn sao chép nội dung của một vùng chọn bằng lệnh Edit > Copy (Ctrl 

+ C), rồi dùng lệnh Edit > Paste (Ctrl + V) để dán nội dung của clipboard 

vào một cửa sổ hình ảnh, thì trên cửa sổ này sẽ xuất hiện một layer mới. 

+ Chọn một vùng chọn trên cửa sổ hình ảnh. Chọn chức năng Layer > New > 

Layer via Copy (Ctrl + J). Động tác này sẽ sao chép nội dung vùng chọn của 

layer/background lên thành một layer mới. Phần nội dung vùng chọn nguồn 

vẫn được giữ nguyên. Người ta thường dùng phím tắt Ctrl + J để đúp layer 

(duplicate layer). 
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+ Chọn một vùng chọn trên cửa sổ hình ảnh. Chọn chức năng Layer > New > 

Layer via Cut (Ctrl + Shift + J). Động tác này sẽ cắt nội dung vùng chọn của 

layer/background lên thành một layer mới. Phần nội dung vùng chọn nguồn 

sẽ được cắt bỏ. 

+ Layer mới cũng là một dạng của layer ảnh. Ta có thể tạo một layer mới và 

trong suốt hoàn toàn bằng cách chọn Layer > New > New… (Ctrl + Shift + 

N) hoặc bấm chuột vào biểu tượng   trên Layers panel. 

− Type layer: Khi bạn dùng công cụ Type    để đánh chữ lên một cửa sổ hình 

ảnh thì trên Layers panel sẽ xuất hiện một layer mới. Layer mới sinh ra gọi là 

Type layer (layer chữ) sẽ chứa nội dung của văn bản mà bạn gõ vào. Layer này 

sẽ được đặt tên là các từ đầu tiên của nội dung gõ vào. 

2 SỬ DỤNG CÁC LỆNH TRÊN LAYER  

2.1 Palette Layer 

 

1: Opacity: Độ trong suốt (độ mờ đục) 

của Layer. 

2: Fill: Độ trong suốt của các Pixel màu 

(không kể màu do hiệu ứng Layer 

Style tạo ra). 

3: Blending Mode (chế độ hòa trộn lớp) 

4: Các chế độ khóa Layer 

5: Ẩn / Hiện Layer. 

6: Ô ảnh hiển thị trước. 

7: Lớp nền Background (mặc định là 

không di chuyển được). 

8: Liên kết các Layer được chọn 

9: Add a Layer Style: Hiệu ứng trên 

Layer 

10: Add a mask: Tạo một lớp mặt nạ 

http://homasg.com/wp-content/uploads/2015/03/PTS_028-copy.png
http://homasg.com/wp-content/uploads/2015/03/PTS_028-copy.png
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mới 

11: Create a new fill or adjustment 

Layer: Phủ lên đối tượng một lớp 

màu hay một lớp hiệu chỉnh mới. 

12: Create a new Group: Tạo một group 

mới (thư mục chứa các Layer con 

bên trong). 

13: Tạo một Layer mới. 

14: Xóa Layer, xóa hiệu ứng, xóa mặt 

nạ 

2.2 Thao tác với layer 

2.2.1 Chọn Layer làm việc 

− Click chuột trực tiếp trên Layer. 

− R-click trực tiếp lên màn hình ảnh > Chọn tên Layer. 

− Bấm giữ Ctrl và Click vào hình ảnh cần chọn. 

2.2.2 Đổi tên Layer 

− Click đôi chuột trực tiếp trên Layer. 

− Khi tên Layer được bôi xanh thì bạn gõ tên mới vào 

− Nhấn Enter 

2.2.3 Tạo lớp mới 

− Click biểu tượng ―Create a new Layer‖ (Nút số 13 trong pallete layer) phía dưới 

Palette Layer. 

− Menu Layer > New > Layer (Ctrl + Shift + N). 

2.2.4 Xoá bỏ lớp 

− Chọn 1 hoặc nhiều Layer / nhấn nút Delete. 

− Chọn và kéo Layer muốn xóa vào biểu tượng thùng rác (Nút số 14 trong pallete 

layer) 

http://wp.me/p5G3rw-9f
http://wp.me/p5G3rw-9f
http://wp.me/p5G3rw-9f
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2.2.5 Copy 1 lớp 

− Chọn Layer > Ctrl + J  

− Chọn Layer > Chọn công cụ Move > Bấm giữ Alt + drag mouse. 

− Chọn và kéo Layer muốn nhân đôi vào biểu tượng ―Create a new Layer‖ 

− Click chuột phải vào Layer / Duplicate Layer. 

2.2.6 Thay đổi trật tự lớp 

− Cách 1: Chọn Layer, giữ và kéo Layer trực tiếp trên Palette Layer.  

− Cách 2: Chọn Layer muốn di chuyển thứ tự lớp > Menu Layer > Arrange: 

+ Bring Forward (Ctrl + ] ) : Đưa Layer được chọn lên trên một lớp. 

+ Send Backward (Ctrl + [ ) : Đưa Layer xuống dưới một lớp. 

+ Bring to Front (Ctrl + Shift + ] ) : Đưa Layer lên lớp trên cùng. 

+ Send to Back (Ctrl + Shift + [ ) : Đưa Layer xuống lớp trên cùng. 

+ Reverse: đảo ngược layer  

2.2.7 Ẩn, hiện các lớp 

Nhấn vào hình con mắt trước Layer trong pallete layer 

2.2.8 Nối, mở nối các lớp 

− Chọn các Layer muốn liên kết/ Click vào biểu tượng  

Lưu ý:  

− Sau khi đã nối các Layer lại thì bất kỳ tác động nào cũng được áp dụng lên tất 

cả Layer được kết nối  

2.2.9 Độ trong suốt của Layer 

- Chọn Layer 

- Kéo thanh trược/ gõ số cụ thể vào ô Opacity/ Fill 

  

2.2.10 Gộp lớp các Layer: 

− Chọn các Layer cần gộp > Click chuột phải hoặc chọn trong menu Layer: 

http://homasg.com/wp-content/uploads/2015/04/PTS_036.png
http://homasg.com/wp-content/uploads/2015/04/PTS_036.png
http://homasg.com/wp-content/uploads/2015/04/PTS_036.png
http://homasg.com/wp-content/uploads/2015/04/PTS_036.png
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− Merge Layers (Ctrl + E) : Gộp tất cả các Layer đang được chọn thành một 

Layer độc lập. 

− Merge Visible (Ctrl + Shift + E) : Gộp tất cả các lớp đang hiển thị. 

− Flatten Image : Làm phẳng lớp (gộp tất cả các lớp lại thành một lớp 

background). 

2.3 Các phép biến đổi hình học trên layer 

Để thực hiện các phép biến đổi hình học trên layer, bạn chọn Edit > 

Transform. Khi đó ở vùng biên của các pixels trên layer sẽ xuất hiện một khung 

hình chữ nhật với các ô vuông nhỏ ở 4 góc và 4 điểm giữa. Các ô vuông này được 

gọi là các handles.  

− Scale (co dãn): Bạn hãy đặt con trỏ tại 1 trong 8 handles. Khi đó con trỏ sẽ có 

dạng  . Nhấn giữ và rê chuột để thực hiện việc co dãn nội dung của layer. Để 

co dãn mà vẫn giữ đúng tỷ lệ, bạn đặt con trỏ vào handles góc, nhấn giữ Shift 

và rê chuột 

 

− Rotate (quay):  đặt con trỏ ra bên ngoài khung chữ nhật. Khi đó con trỏ có 

dạng hình mũi tên cong  . Nhấn giữ và rê chuột để quay nội dung của layer. 

 

Nhấn giữ phím Shift để quay layer đi một bội số của 15o như: 15o, 30
o
, 45

o
, 

60
o
 

− Skew (kéo nghiêng): đặt con trỏ vào 1 trong 4 handles ở điểm giữa. Khi đó con 

trỏ có dạng  . Nhấn giữ và rê chuột để kéo nghiêng nội dung của layer. 
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− Distort (biến dạng): đặt con trỏ vào 1 trong 4 handles ở các góc. Khi đó con 

trỏ có dạng đầu mũi tên   . Nhấn giữ và rê chuột để làm biến dạng nội dung 

của layer. Bạn sẽ thấy các handles ở các góc còn lại vẫn giữ nguyên vị trí. 

 

− Perspective (phối cảnh): đặt con trỏ vào 1 trong 4 handles ở các góc. Khi đó 

con trỏ có dạng đầu mũi tên   . Nhấn giữ và rê chuột để tạo phối cảnh cho nội 

dung của layer. 

 

− Warp (uốn cong): khi thực hiện chức năng này, một lưới (mesh) sẽ xuất hiện 

bao quanh nội dung của layer. Bạn hãy đặt con trỏ vào các điểm điều khiển 

(control points) hoặc lên các đường ngang/dọc của lưới và rê chuột. Nội dung 

của layer sẽ được uốn theo lưới. 
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− Canh lề cho Layer 

+ Chọn các Layer muốn canh hàng. Dùng thanh thuộc tính của công cụ Pick 

tool 

 

+ Menu Layer > Align 

 

Chú thích: 

+ Align Top Edges : Canh bằng nhau trên đỉnh. 

+ Align Vertical Centers : Canh giữa theo phương dọc. 

+ Align Bottom Edges : Canh bằng nhau dưới đáy. 

+ Align Left Edges : Canh trái. 

+ Align Horizontal Centers : Canh giữa theo phương ngang. 

+ Align Right Edges : Canh phải. 
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− Rotate 180
o
: quay nội dung layer đi 180

o
 

− Rotate 90
o
 CW (clockwise): quay nội dung layer đi 90

o
 cùng chiều kim đồng 

hồ. 

− Rotate 90
o
 CCW (counter – clockwise): quay nội dung layer đi 90

o
 ngược 

chiều kim đồng hồ 

− Flip Horizontal: lật hình ảnh ngang 

 

Lật ngang tương đương với đối xứng hình ảnh qua trục dọc 

− Flip Vertical: lật hình ảnh dọc 

 

Lật ngang tương đương với đối xứng hình ảnh qua trục ngang 

− Ngoài ra bạn cũng có thể thực hiện biến hình tự do trên layer bằng cách chọn 

chức năng Edit > Free Transform (Ctrl  + T). Chức năng rất tiện lợi này cho 

phép bạn thực hiện năm phép biến hình cùng một lúc (5 trong 1). 
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Lưu ý: 

Khi biển đổi các điểm ảnh của hình sẽ thay đổi làm giảm chất lượng ảnh. Để 

giải quyết vấn về này  trước khi biến đổi hình bạ nên chuyển hình sang dạng đối 

tượng thông minh (smart object).  

Để chuyển một layer thường sang đối tượng thông minh, bạn bấm mắt phải 

chuột (right-click) lên layer mong muốn trên Layers panel. Một thực đơn sẽ hiện 

ra và bạn sẽ chọn chức năng Convert to Smart Object: 

 

Khi nào bạn hài lòng với kết quả biến hình, bạn mới cần đổi đối tượng thông 

minh trở lại thành layer thường bằng cách bấm mắt phải chuột (right-click) lên 

layer trên Layers panel. Một thực đơn sẽ hiện ra và bạn sẽ chọn chức năng 

Rasterize Layer. Lúc này Photoshop mới thực hiện biến đổi một lần và khoogn 

gây mất nét của hình. 
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3 CÁC CHẾ ĐỘ HÒA TRỘN  

3.1 Blending Mode (chế độ hoà trộn) 

 

− Normal : Mặc định chuẩn, không cần hòa 

trộn. 

− Dissolve : Tạo hiệu ứng cọ vẽ khô trong một 

lượng Pixel được hòa trộn. 

 

− Darken : Kết quả nghiêng về màu tối, sắc độ 

ẩm vẫn được bảo toàn, đậm hơn so với ảnh 

ban đầu. 

− Multiply : Kết quả đậm hơn so với ảnh ban 

đầu và có sự hòa trộn đều màu sáng và màu 

tối. 

− Color Burn : Tạo ra hiệu ứng chiếu sáng 

thường nghiêng về sắc nâu đỏ, những màu 

sáng trở nên rực rỡ, hiệu ứng thường tạo ánh 

sáng gắt trên nền đậm. 

− Linear Burn : Hiệu ứng gần giống Color 

Burn nhưng độ chuyển màu bớt gắt hơn các 

chế độ chuyển sáng tối. 
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− Lighten : Tạo ra kết quả sáng hơn so với ảnh 

ban đầu và làm giảm độ đậm trên hình ảnh. 

− Screen : Sáng hơn so với ảnh ban đầu, chế 

độ này ngược với hiệu ứng Multiply. 

− Color Dodge : Làm sáng màu nền để làm 

nổi bật màu hòa trộn thường nghiêng về 

những màu rực rỡ. 

− Linear Dodge : Hiệu ứng gần giống Color 

Dodge nhưng độ sáng bớt gắt. 

 

− Overlay : Ở chế độ này thường nghiêng về 

sắc độ nóng và rực rỡ. 

− Soft Light : Hiệu ứng gần giống Overlay 

nhưng độ tương phản bị giảm đi, ảnh hưởng 

cho ánh sáng dịu. 

− Hard Light : Kết quả nghiêng về màu đậm. 

− Vivid Light : Tạo ảnh có độ rực rỡ làm tăng 

độ tương phản so với ảnh ban đầu. 

− Linear Light : Gần giống với hiệu ứng Vivid 

Light nhưng giảm độ tương phản. 

− Pin Light : Tạo kết quả rực rỡ màu tuy nhiên 

có tăng thêm các cấp độ trung gian. 

 

− Difference : Kết quả tạo ra một màu thứ ba 

khác biệt so với hệ màu ban đầu. 

− Exclusion : Gần giống với hiệu ứng 

Difference nhưng bị giảm độ tương phản. 

 

− Hue : Màu sắc bị hòa trộn và lẫn vào màu 

nền. Ở chế độ này thường có tông màu xám. 

− Saturation : Kết hợp độ xám và sắc độ của 

màu hòa trộn với màu nền. 

− Color : Hòa trộn có bảo lưu độ sáng tối của 
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màu nền với sắc độ và cường độ của màu 

hòa trộn. 

− Luminosity : Nghiêng về thang độ xám 

nhưng màu rực rỡ ít bị hòa trộn. 
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BÀI 4: CÔNG CỤ TÔ VẼ 

Mã bài: MĐ18_04 

GIỚI THIỆU 

Bài 4 hướng dẫn bạn sử dụng 2 nhóm công cụ để chỉnh sửa hình ảnh 

- Nhóm hổ trợ cho việc tô vẽ, trang trí thêm cho hình ảnh.  

- Nhóm chỉnh sửa, khắc phụ ảnh 

MỤC TIÊU 

− Trình bày chức năng bộ công cụ tô vẽ; 

− Sử dụng thành thạo bộ công cụ tô vẽ; 

− Sử dụng thành thạo bảng màu; 

− Có được tính cẩn thận, linh hoạt, sáng tạo, óc thẩm mỹ. 

NỘI DUNG CHÍNH 

1 CÁC CÔNG CỤ TÔ VẼ  

1.1 Bộ công cụ Bursh 

  (phím tắt: B) 

− Brush Tool: công cụ này phù hợp cho việc tô sơn, vẽ các đường nét mềm mại 

với kiểu nét vẽ và hình mẫu có sẵn.  

− Cách vẽ :Click chuột – giữ – rê trên trang giấy. 

1.1.1 Định dạng Brush 

 

− Kích thước cọ vẽ 

− Palette Brush 

− Kiểu vẽ 

− Độ trong suốt của nét vẽ 

1.1.2 Định dạng lại các mẫu Brush 

Thay đổi định dạng của Brush 
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− Các mẫu Brush thường có sẵn nếu muốn thay đổi các thông số định dạng bạn 

vào cửa sổ Brush 

 

− Click đôi vào các mục định dạng 

− Từ đó thay đổi các thông số để có kiểu Brush mới 

Thông số riêng 

+ Shape Dynamics: xoay, bóp dẹp đầu cọ một cách ngẫu nhiên  

+ Scattering: Xác định độ phân tán, chi phối số lượng và vị trí các đầu cọ trên 

nét vẽ. 

+ Texture: áp chất liệu cho đầu cọ  

+ Dual Brush: Xén nét của đầu cọ 1 cách ngẫu nhiên 

+ Color Dynamics: Quản lý việc thay đổi màu sắc trên đường đi của nét vẽ.  

+ Noise: tạo hạt quanh viền đầu cọ. 

+ Smoothing: mềm mại hơn về hình dáng đầu cọ và cả độ phân tán nét vẽ. 

Thông số chung 

+ Size: kích thước đầu cọ. 

+ Flip X / Flip Y: xoay đầu cọ hướng đối xứng theo chiều ngang / dọc. 

+ Angle: xoay các đầu cọ đồng loạt theo 1 hướng nhất định. 

+ Rounded: ―bóp dẹp‖ đầu cọ theo hướng của Angle 

+ Hardness: nét cọ đậm đều hoặc nhòe từ biên vào. 

+ Spacing: Khoảng cách giữa các đầu cọ trong một nét vẽ. 

Load Brush 

− Dowload các kiểu Brush có sẵn trên mạng về máy 

− Click biểu tượng  > Chọn tên thư viện cần Load. 

http://homasg.com/wp-content/uploads/2015/05/PTS_070.png
http://homasg.com/wp-content/uploads/2015/05/PTS_070.png
http://homasg.com/wp-content/uploads/2015/05/PTS_070.png
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1.1.3 PencilTool  

Công cụ dùng để vẽ nét sắc, mảnh. 

1.1.4 Color Replacement Tool 

Sử dụng để thay thế màu sắc trên hình ảnh với tông 

màu Foreground. 

1.1.5 Mixer Brush Tool  

Hòa trộn màu Foreground và Background cho ra một 

màu trung tính theo thông số trên thanh đặc tính. 

1.2 Bộ công cụ tẩy (Erase) 

Eraser Tool (phím tắt: E): Đây là công cụ dùng để xóa một vùng ảnh. Nếu ảnh 

là layer Background hoặc bị khóa thì vùng bị xóa sẽ lấy theo màu Background 

Color.  

Nhấn Shift + E để chuyển giữa chế độ xóa Eraser, Background Eraser, hay 

Magic Eraser. 

 

http://homasg.com/wp-content/uploads/2015/05/PTS_064.png
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http://homasg.com/wp-content/uploads/2015/05/PTS_066.png
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− Eraser Tool : Xóa các pixel hình ảnh của Layer hoặc xóa màu mặt (foreground) 

của lớp nền (thấy màu background). 

− Background Eraser Tool : Xóa các pixel hình ảnh để trả về màu trong suốt (kể 

cả Layer lẫn background). 

− Magic Eraser Tool : Tẩy xóa nền theo vùng màu tương đồng. 

1.3 Bộ công cụ Stamp 

Clone Stamp Tool (phím tắt: S): Đây cũng là một công cụ brush sửa ảnh khác, 

giữ Alt và kích chuột vào vùng nền "nguồn" và sau đó kích chuột trái chọn vùng 

nền muốn "phủ" vùng "nguồn" lên. Nhấn Shift + S để chọn các công cụ đóng dấu 

khác nhau. 

 

1.3.1 Clone Stamp Tool: 

− Tính chất: Dùng để sao chép những điểm hình ảnh. 

− Thao tác: Chọn công cụ Clone Stamp > chọn kiểu và độ lớn nét cọ, ấn định các 

tùy chọn khác cho nét cọ. Sau đó bấm giữ phím Alt và click lên hình ảnh để 

chọn điểm nguồn (phần ảnh sạch gần với vùng ảnh dơ nhất) tiếp tục di chuyển 

con trỏ sang vị trí thứ hai (vùng ảnh dơ) rồi click từng điểm một. 

 

1.3.2 Pattern Stamp Tool: 

Vì công cụ này nằm chung nhóm nên tôi nói luôn chứ không ai dùng công cụ 

này để xóa vết bẩn hết (mặc dù trên lý thuyết nó vẫn xóa được). 

− Tính chất : Dùng để tô vẽ với họa tiết được chọn từ thư viện hay tự tạo. 

http://homasg.com/wp-content/uploads/2015/08/PTS_108.png
http://homasg.com/wp-content/uploads/2015/08/PTS_109.jpg
http://homasg.com/wp-content/uploads/2015/08/PTS_108.png
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− Thao tác : Chọn công cụ > chọn kiểu họa tiết trên thanh Option > Drag mouse 

tô lên vùng chọn hoặc Layer định sẵn. 

− Tạo mẫu Pattern mới: 

+ Dùng công cụ chọn vùng hình chữ nhật > Rectangular Marquee Tool, 

feather = 0 

+ Tạo vùng chọn làm mẫu Pattern. 

+ Chọn Menu Edit > Define Pattern > OK. 

+ Tắt vùng chọn > Ctrl + D 

− Sử dụng mẫu Pattern: 

+ Chọn công cụ Pattern Stamp 

+ Chọn mẫu tô vừa tạo trong thư viện Pattern trên thanh Option 

+ Click và rê chuột liên tục trên hình ảnh 

+ Kết quả : Những mẫu Pattern sẽ hiện liên tục trên màn hình. 

1.4 Bộ công cụ History Brush 

  History Brush Tool (phím tắt: Y): Làm việc song song với History Palette, 

bạn có thể "lấy lại màu gốc" với công cụ này. Sử dụng như một công cụ lọc, bạn 

chọn phần muốn lấy lại màu nền như ảnh gốc (phần được chọn phải nằm trong 

vùng đã bị thay đổi nền).  

Nhấn Shift + Y để thay đổi giữa History Brush Tool và Art History Brush 

Tool. 

 

− History Brush Tool: Công cụ phục hồi hình ảnh trở về trạng thái ban đầu. 

− Art History Brush Tool: Cọ vẽ nghệ thuật 

1.5 Bộ công cụ Gradient/ Pain Bucket 

http://homasg.com/wp-content/uploads/2015/05/PTS_074.png
http://homasg.com/wp-content/uploads/2015/05/PTS_074.png
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  Gradient Tool (phím tắt: G): Kích và kéo gradient màu phủ đầy lên layer hoặc 

vùng mà bạn chọn bằng màu foreground và background trên thanh công cụ. Có rất 

nhiều tùy chọn gradient màu bạn có thể sử dụng. Mở rộng trong công cụ này còn 

có Paint Bucket Tool - dùng để phủ một màu đơn cho 1 vùng hoặc 1 layer đang 

chọn. Nhấn Shift + G để chuyển đổi giữa 2 chế độ phủ màu. 

 

1.6 Bộ công cụ tô sửa 

Spot Healing Brush Tool (phím tắt: J): Rất hữu ích trong việc xóa các vết ố, 

trầy xước không mong muốn trên ảnh. Nhấn Shift + J để thay đổi giữa Healing 

Brush, Patch Tool và công cụ Red Eye (dùng để xử lý mắt đỏ) 

Healing Tool, gồm 5 công cụ: 

 

1.6.1 Spot Healing Brush Tool: 

Sử dụng để xóa nhanh các vết dơ, trầy xướt, khuyết điểm nho nhỏ trên hình 

ảnh hay các hạt chấm chấm, mụn, nốt ruồi…bằng cách tự tập hợp những pixel màu 

xung quanh để che lấp khuyết điểm. 

1.6.2 Healing Brush Tool: 

− Tính chất : Vừa copy vừa so khớp hình ảnh. 

− Thao tác : Tương tự công cụ Clone Stamp. 

− Đây là 1 công cụ rất mạnh, dùng để xóa các nếp nhăn rất tốt. 

 

http://homasg.com/wp-content/uploads/2015/08/PTS_107.png
http://homasg.com/wp-content/uploads/2015/08/PTS_208.png
http://homasg.com/wp-content/uploads/2015/08/PTS_107.png
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http://homasg.com/wp-content/uploads/2015/08/PTS_107.png
http://homasg.com/wp-content/uploads/2015/08/PTS_208.png
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1.6.3 Patch Tool:  

− Tính chất : Copy và so khớp từng mảng hình ảnh. 

− Thao tác : 

+ Source : Rê chọn một vùng ảnh dơ > đặt trỏ vào bên trong vùng chọn > rê 

sang vùng ảnh sạch gần nhất. 

+  Destination : Rê chọn một vùng ảnh sạch gần vùng ảnh dơ nhất > đặt trỏ 

vào bên trong vùng chọn > rê đắp sang vùng ảnh dơ kế bên. 

+ Để mức độ so khớp có màu sắc, sáng tối… chính xác hơn, bạn nên rê vùng 

ảnh dơ sang vùng ảnh sạch gần nó nhất có thể. 

Lưu ý:  

Những công cụ trên chỉ hiệu quả dối với những vùng dơ nhỏ.  

1.6.4 Content-Aware Move Tool 

Công cụ này giúp bạn vừa di chuyển vùng chọn, vừa thấy được vùng để lấp 

vào khoảng chọn đã chuyển đi. 

Ví dụ: trong minh họa dưới đây, chọn công cụ Content-Aware Move Tool, khoanh 

vùng chọn hình cô gái. 

 

− Khi Mode ở chế độ Move, kéo vùng chọn sang bên phải, cô gái sẽ ―chạy‖ sang 

bên phải, chỗ cô gái đứng trước đó được chương trình tự tính toán mà lấy hình 

lúa lấp vào. 

 

− Còn khi Mode ở chế độ Extend, cũng kéo vùng chọn hình cô gái sang bên phải, 

nhưng lúc này, hình cô gái sẽ được nhân bản lên. 

http://homasg.com/wp-content/uploads/2015/08/PTS_118A.png
http://homasg.com/wp-content/uploads/2015/08/PTS_118B.png
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− Chế độ Extend đặc biệt hữu dụng trong trường hợp này: (ví dụ) xóa 2 bọc rác 

dưới chân cột để được 1 hình sạch sẽ thế này. 

 

− Tôi đã dùng Content-Aware Move Tool khoanh vùng sạch kế bên, sau đó kéo 

qua trái để lấp lên cái bọc. 

1.7 Red Eye Tool: 

− Tính chất : Là công cụ dùng để khử mắt đỏ. 

− Thao tác : Chọn công cụ Red Eye và click lên vùng mắt đỏ.  

 

1.8 Bộ công cụ Blur/Sharpen/Smudge 

Blur, Sharpen, and Smudge Tools: mặc định, công cụ này không có phím tắt. 

Có ba công cụ chỉnh sửa ảnh nằm trong nút công cụ này. Smudge là thanh công cụ 

đặc biệt có thể tạo hiệu ứng vuốt màu tuyệt vời trên hình ảnh của bạn. Chuột phải 

vào nút công cụ để chọn những công cụ khác nhau: Blur và Sharpen. 

 

1.8.1 Blur Tool  
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− Dùng để làm mờ các rìa hoặc vùng sắc nét trong hình ảnh để làm giảm bớt chi 

tiết. Chỉ là ―giảm bớt‖ thôi, chứ không có nhòe tuyệt đối như bộ lọc Filter Blur 

(sẽ đề cập vào bài hướng dẫn khác) 

1.8.2 Sharpen Tool 

− Tập trung vào rìa mờ nhằm tăng độ sắc nét, dựa trên nguyên tắc làm tăng độ 

tương phản giữa các pixel kề nhau. 

Ví dụ: 

 

− Dùng Blur Tool để làm nhòe khung cảnh xung quanh (chừa hình anh chàng 

chính giữa ra). Sau đó lại dùng Sharpen Tool để làm rõ anh chàng chính giữa. 

Toàn thể bức hình sau thay đổi, vùng nhìn như tập trung vào anh ta. 

1.8.3 Smudge Tool 

Giống như hành động miết ngón tay qua vùng sơn ướt. Công cụ này lấy màu ở 

vị trí bắt đầu và đẩy nó theo hướng rê chuột. 

Ví dụ: cũng hình trên nhưng chỉ tác động Smudge Tool lên anh chàng chính 

giữa 

 

1.9 Bộ công cụ Dodge/Burn/Sponge 

Dodge and Burn Tools (phím tắt: O): Dodge và Burn là công cụ chỉnh sửa giúp 

làm sáng hoặc tối một vùng cho bức ảnh. Nhấn Shift + O để thay đổi lựa chọn giữa 

các công cụ. 
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Ví dụ: 

 

1.9.1 Dodge Tool 

− Dùng để làm tăng độ sáng cho hình ảnh. 

− Có 3 chế độ Range: Shadows (độ sáng thấp như trong bóng râm), Midtones (độ 

sáng trung bình), và Highlights (độ sáng tương phản cao). 

 

+ Điều chỉnh đầu cọ ―mềm‖, ―cứng‖ …  

+ Điều chỉnh mức độ đậm nhạt của mỗi lần quét thì vào Exposure, bên phải 

Range. 

+ Để mặc định kiểm nhận Protect Tones để màu sắc không bị lệch quá nhiều. 
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− Tôi cố ý quét quá tay một chút để bạn thấy rõ sự khác biệt, thực tế thì chỉ quét 

nhẹ qua thôi nhé, làm quá sẽ hỏng bức hình. 

1.10 Burn Tool 

− Làm tăng độ tối cho hình ảnh. 

− Có 3 chế độ Range:  

+ Shadows (những phần tối sẽ tối hơn, những phần sáng thì tương phản đậm 

hơn),  

+ Midtones (trông như tô thêm 1 lớp màu tương đồng đậm hơn)  

+ Highlights (trông như tô thêm 1 lớp màu xám). 

Ví dụ:  như trong hình này dùng Burn Tool quét qua khu vực các căn nhà với 

Range ở chế độ Hightlights. 

 

1.10.1 Sponge Tool 

− Dùng để làm cho màu sắc của hình ảnh bão hòa hoặc rực rỡ hơn. 

− Mode trên thanh đặc tính có 2 chế độ: 

+ Desaturate: chế độ phi bão hòa, hình ảnh được đưa về trạng thái cân bằng 

trắng. 

+ Saturate: nghĩa đen là bão hòa nhưng hình ảnh như được thêm 1 lớp màu 

tương đồng đậm làm màu sắc thêm rực rỡ hơn. 
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2 LÀM VIỆC TRÊN BẢNG MÀU  

2.1 Bảng color 

 

2.2 Màu tiền cảnh 

Background/Foreground  

Đây là công cụ hiển thị 2 màu đang được sử dụng. Màu trên là Foreground, 

màu dưới là Background.  

− Nhấn phím X trên bàn phím để chuyển đổi màu Foreground thành Background 

và ngược lại.  

− Nhấn phím D để đưa 2 màu này về mặc định là trắng và đen. 

2.3 Bảng Swatches 

Swatches  

Đây là nguồn tài nguyên màu có sẵn hay được tạo trong quá trình người dùng 

thiết kế và lưu lại các tone màu tự phối. 

Bạn có thể tạo một swatch mới từ màu foreground bằng cách kích vào  và 

chọn ―New Swatch‖ 
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2.4 Công cụ hút màu 

 

− Eyedropper Tool: Hút lấy mẫu màu trên hình ảnh, màu được hút sẽ hiển thị trên 

ô màu foreground. 

− Color Sampler Tool: Hút lấy thông số màu, tối đa là 4 thông số. 

− Ruler Tool: Đo đạc kích thước hình ảnh. Một ứng dụng khác của công cụ 

Measure là cân chỉnh hình ảnh bị nghiêng trở về trạng thái thẳng:  

+ Dùng công cụ Measure rê dọc theo bờ xiên của hình ảnh  

+ Menu Image / Rotate Canvas / Arbitrary / OK 

− Note Tool: Thêm phần ghi chú. 

− Count Tool: Dùng để đếm/ đánh số cho những chi tiết bạn muốn. 

2.5 Công cụ Gradient 

2.5.1 Có 5 kiểu tô 

− Linear Gradient: Màu biến thiên từ điểm đầu đến điểm cuối theo đường thẳng. 

 

− Radial Gradient: Màu biến thiên từ điểm đầu đến điểm cuối theo dạng tỏa tròn. 
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− Angle Gradient: Màu biến thiên nghịch chiều kim đồng hồ xung quanh điểm 

bắt đầu (giống hình chóp nón). 

 

− Reflected Gradient: Màu biến thiên dựa trên mẫu Gradient tuyến tính đối xứng 

ở một bên điểm bắt đầu. 

 

− Diamond Gradient: Màu biến thiên từ điểm bắt đầu hướng ra ngoài theo dạng 

hình thoi. Điểm cuối quyết định một góc của hình thoi. 

 

Ngoài ra, bạn cũng có thể chọn chế độ hòa trộn Mode, độ mờ đục Opacity, 

nghịch đảo màu check chọn Reverse. 

Để mở bảng Gradient Editor, bạn click vào biểu tượng mảng màu (kế bên biểu 

tượng Gradient Tool). 

2.5.2 Bảng màu Gradient 

Mẫu đầu tiên sẽ lấy  màu foreground và background làm chuẩn, ngoài ra còn 

có các mẫu có sẵn. Bạn có thể tự phối lại màu trên thanh màu 

Cách phối màu: 

- Chọn màu lại cho từng điểm, Click đôi vào nút có hình tam giác trên thanh 

màu 

- Chọn vị trí cần chèn thêm màu, Click đôi để thêm. Mỗi nút tam giac sẽ là 

một màu phối. 
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2.5.3  Công cụ Paint Bucket  

 

Nằm cùng nhóm với Gradient Tool. 

Dùng để tô màu đồng nhất hoặc một mẫu họa tiết (Pattern) vào những pixel 

liền kề có giá trị màu tương tự với pixel vừa click chọn. 

Thông thường nên kết hợp với các chế độ hoà trộn để phối màu cho các điểm 

ảnh. 
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BÀI 5: CÔNG CỤ PEN , SHAPE VÀ TYPE  

Mã bài: MĐ18_05 

GIỚI THIỆU 

Bài 5 giới thiệu công cụ vẽ hình có sẵn Shape và công cụ Pen giúp người dùng 

có thể linh hoạt trong việc thiết kế sản phẩm. Ngoài ra, chức năng tạo đường Path 

cũng hổ trợ cho người dùng trong việc tạo vùng chọn phức tạp. 

MỤC TIÊU: 

− Thực hành vẽ bằng công cụ Pen; 

− Tô và chỉnh sửa path; 

− Biến đổi path thành vùng lựa chọn và ngược lại; 

− Sử dụng thành thạo công cụ Shape và Type để tạo hình 

− Rèn luyện tính sáng tạo, thẩm mỹ. 

NỘI DUNG CHÍNH 

1 CÔNG CỤ PEN VÀ PATH 

1.1 Công cụ Pen 

1.1.1 Nhóm công cụ Pen  

 

− Pen Tool : Công cụ chính để tạo đường Path. 

− Freeform Pen Tool : Vẽ đường Path bằng cách rê chuột tự do. 

−  Add Anchor Point Tool : Thêm node. 

− Delete Anchor Point Tool : Xóa node. 

− Convert Point Tool : Hiệu chỉnh tay nắm, biến node gãy nhọn thành node trơn, 

mịn. 

1.1.2 Vẽ hình bằng Pen 
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Cách vẽ: 

- Chọn công cụ Pen 

- Thiết lập các thông số trên thanh công cụ 

- Click chuột tạo các điểm nối với nhau 

Thanh công cụ: 

 

1. Vẽ hình khép kín 

2. Màu nền 

3. Có viền / không có viền – Màu viền 

4. Độ dày đường viền 

5. Kiểu đường viền 

6. Kích thước hình 

  

1.2 Công cụ path 

1.2.1 Vẽ đường Path bằng Pen 

− Thanh thuộc tính 

1 2 3 4 5 6 
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Vẽ các đoạn thẳng  

Vẽ đoạn gấp khúc   

Vẽ đoạn cong  

+ Thêm node: Dùng Add Anchor Point Tool và click chuột trên đường path để 

thêm. 

+ Xóa bỏ node: Dùng Delete Anchor Point Tool và click ngay vào node cần 

xóa. 

+ Chỉnh để biến node gãy nhọn thành node cong mịn: Dùng Convert Point 

Tool để điều chỉnh 2 tay nắm của từng node. 

+ Giữ phím Ctrl + kéo rê chuột trái là có thể di chuyển vị trí của node. 

+ Giữ phím Alt + click vào node có thể biến góc cong thành nhọn. 

− Định dạng đường Path 

 

+ Fill: Tô màu nền 

+ Stroke: tô màu viền 

+ Free transforn Path: kéo kích 

thước, bóp méo,… 

 

Lưu ý: 
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Đối với đường Path thì phái chọn và chỉnh sửa bằng công cụ. cách dùng hoàn 

toàn giống công cụ Shape 

 

1.2.2 Chuyển đường Path thành vùng chọn 

− Vẽ đường Path 

− Click phải chuột vào đường Path  

− Chọn Make Selecttion/ thiết lập thông số Feather vùng chọn 

2 CÔNG CỤ SHAPE 

 

Cách thực hiện 

− Chọn hình trong nhóm công cụ 

− Thiết lập các thuộc tính 

− Click chuột vẽ một hình chữ nhật lên trang giấy 

 

 

+ Chọn vẽ hình có nền (Shape) / đường viền (Path) 

+ Màu nền 

+ Nàu viền 
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+ Độ dày đường viền 

+ Kích thước hình 

Lưu ý: 

Khi vẽ 2 hình trong cùng một Layer thì trước khi vẽ hình thứ 2 cần chọn một 

trong các mục sau:   

 

− Tạo layer mới 

− Kết hợp 2 hình với nhau thành 1 

hình 

 

− Hình thứ 2 cắt hình thứ 1 

 

 

− Lấy phần giao của 2 hình 

 

 

− Lấy toàn bộ 2 hình trừ phần giao 

nhau 

 

 

 

 

 

3 CÔNG CỤ TYPE 
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3.1 Nhóm công cụ Text 

− Công cụ Text dùng để gõ văn bản trang trí hình ảnh 

− Horizontal Type Tool : Công cụ tạo văn bản ngang. 

− Vertical Type Tool : Công cụ tạo văn bản dọc. 

− Horizontal Type Mask Tool : Công cụ tạo văn bản ngang với hình thức là vùng 

chọn. 

− Vertical Type Mask Tool : Công cụ tạo văn bản dọc với hình thức là vùng chọn. 

3.2 Thuộc tính của Text 

 

− Hầu như không có gì xa lạ nhỉ?! Từ trái sang phải, lần lượt là 

− Định hướng ngang/dọc cho chuỗi kí tự 

− Font 

− Kiểu chữ (bold, Italic,… ) 

− Kích thước chữ 

− Uốn cong khối/ chuỗi kí tự 

− Canh lề 

− Màu chữ 

− Biến dạng khối/ chuỗi kí tự 

− Mở palette Paragraph 

− 2 nút nằm riêng biệt bên ngoài là bỏ chọn / kiểm chọn định dạng vừa thao tác. 

3.3 Uốn cong chữ 

− Chọn lớp chữ. 

− Thực hiện một trong hai cách: 

+ Cách 1: Chọn công cụ Type, nhấp vào biểu tượng Create Warped 

Text  trên thanh đặc tính. 

+ Cách 2: Click chuột phải ngay layer text đó > chọn Warp Text… Hoặc vào 

menu Type > Warp Text… 

http://homasg.com/wp-content/uploads/2015/06/PTS_086.png
http://homasg.com/wp-content/uploads/2015/06/PTS_086.png
http://homasg.com/wp-content/uploads/2015/06/PTS_086.png


 

63 

Lưu ý: 

Phần trong suốt của Type layer mặc nhiên sẽ được bảo vệ (preserve 

transparency). Để có thể thao tác với phần trong suốt này, bạn cần đổi layer 

chữ thành layer thông thường bằng cách chọn: Layer > Rasterize > Type. 
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BÀI 6: CHỈNH SỬA MÀU SẮC 

Mã bài: MĐ18_06 

GIỚI THIỆU  

Bài này hướng dẫn bạn sử dụng menu Select, trong nhóm công cụ select bạn đã 

làm quen với một số tính năng nhưng còn những tính năng it dùng được cất trong 

menu. Sau khi đã thành thạo việc chọn lựa, bạn sẽ được hướng dẫn cách chỉnh sửa 

về màu sắc. 

MỤC TIÊU 

− Liệt kê các chế độ hiển thị hình ảnh trong môi trường Photoshop; 

− Liệt kê lệnh điều chỉnh màu sắc; 

− Xem ảnh với chế độ bất kỳ; 

− Điều chỉnh màu sắc tùy ý; 

− Có được tính sáng tạo, thẩm mỹ, cách tổ chức khoa học. 

NỘI DUNG CHÍNH 

1 CÁC CHẾ ĐỘ HIỂN THỊ ẢNH  

− Photoshop cho phép xem ảnh từ 0,67% đến 3200%. 

− Để phóng to: Ctrl + phím (+) 

− Để thu nhỏ: Ctrl + phím (-) 

− Nhấn giữ Ctrl + Alt và phím + (hoặc -) để phóng to hoặc thu nhỏ cả hình ảnh và 

cả trang chứa hình ảnh đó. 

− Nhấn giữ Ctrl + Alt và phím số 0 để đưa hình ảnh về tỷ lệ 100%. 

− Để xác định chính xác phần hình ảnh muốn phóng to hay thu nhỏ: Chọn công 

cụ Zoom tool (phím Z) sau đó rê đến phần hình ảnh cần phóng to hay thu nhỏ 

đó và nhấp chuột. Hoặc giữ Ctrl + Space bar và rê chuột để phóng to 1 khu vực. 

− Có thể phóng to, thu nhỏ hình ảnh bằng menu View –> Zoom In / Zoom Out … 

− Menu Window –> Navigator. Bấm kéo thanh trượt qua trái/ phải hoặc nhập 

thông số cụ thể trong ô giá trị. Dùng chuột kéo rê ô màu đỏ trên palette 

Navigator để di chuyển tới vùng hình ảnh muốn phóng to. 

2 QUẢN LÝ VÙNG CHỌN (MENU SELECT) 

2.1 Các lệnh đơn 
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− Lệnh Select All (Ctrl + A): Tạo vùng chọn bao kín toàn bộ hình ảnh. 

− Lệnh Deselect (Ctrl + D): Hủy vùng chọn. 

− Lệnh Reselect (Ctrl + Shift + D): Lấy lại vùng chọn đã hủy. 

− Lệnh Inverse (Ctrl + Shift + I): Nghịch đảo vùng chọn.  

− Lệnh Grow: Nới rộng vùng chọn có vùng màu gần nhất (chọn màu cục bộ). 

− Lệnh Similar: Dò tìm trên toàn file tất cả các mẫu màu trùng với màu đã chọn 

ban đầu và chọn hết toàn file theo tông màu đã chọn. 

− Lệnh Transform Selection: Phóng to, thu nhỏ, xoay,…vùng chọn. Giữ Shift 

bấm vào một trong bốn nút vuông vùng chọn sẽ đều hơn (hoặc ta có thể click 

phải chuột vào bên trong vùng chọn để chọn chế độ Transform Selection). 

2.2 Color Range:  

− Selection: Ô preview chỉ hiển thị hình ảnh dưới dạng màu trắng, đen. Vùng có 

có màu trắng là vùng được chọn, vùng màu đen là vùng không được chọn. 

− Image: Ô preview hiển thị dạng ảnh màu. 

− Dùng 3 bút lấy màu để xác định màu cần chọn 

− Điều chỉnh thuộc tính Fuzziness để tăng giảm lượng màu tương ứng. 

2.3 Lệnh Modify:  

Điều chỉnh vùng chọn 

− Border: Tạo khung biên vùng chọn – Width: Độ rộng của biên 

− Smooth: Bo góc vùng chọn – Sample Radius: Góc bo 

− Expand: Mở rộng đều chu vi vùng chọn – Expand By: Số pixel được nới rộng 

đều các bên của vùng chọn. 

− Contract: Thu hẹp đều chu vi vùng chọn – Contract By: Số pixel bị thu hẹp đều 

các bên của vùng chọn. 

− Feather (Shift + F6; Phiên bản CS3 phím tắt là Ctrl + Alt + D): Làm mờ biên 

vùng chọn, tùy thuộc vào giá trị Feather Radius. 

2.4 Lệnh Edit in Quick Mask Mode:  

Dùng để chọn nhanh vùng chọn với sự hỗ trợ của công cụ Pen.  
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− Cách dùng: Sau khi chọn lệnh này, dùng Pen Tool vẽ trực tiếp lên vùng bạn 

muốn chọn trên đối tượng, khu vực chọn lúc này có màu đỏ. Sau khi vẽ vùng 

chọn xong, vào Select > Load selection. 

2.5 Lệnh Load Selection:  

Tải vùng chọn đã lưu trữ. 

− New selection: Vùng chọn mới. 

− Add to selection: Vùng chọn mới sẽ là sự kết hợp của vùng chọn vừa vẽ với 

vùng chọn có sẵn trong kênh đã chọn. 

− Subtract from selection: Vùng chọn mới sẽ là phần còn lại sau khi vùng chọn 

vừa vẽ cắt vùng chọn có sẵn trong kênh được chọn. 

− Intersect with selection: Vùng chọn mới sẽ là phần giao nhau của vùng chọn 

vừa vẽ với vùng chọn có sẵn trong kênh được chọn. 

− Có kiểm nhận Invert để nghịch đảo vùng chọn. 

2.6 Lệnh Save Selection:  

Lưu vùng chọn, vùng chọn được lưu sẽ hiển thị trong kênh Alpha, và đặt tên 

cho vùng chọn đó. 

3 ĐIỀU CHỈNH MÀU SẮC    

3.1 Lệnh Color Balance (Ctrl + B) 

− Dùng để cân bằng màu sắc. 

− Thao tác : Rê các thanh trượt để cân bằng màu. 

 

− Tone Shadows, Midtones, Highlights sẽ tác động lên màu sắc của những 

vùngtối, trung bình và sáng tương ứng trên ảnh cần chỉnh 

http://homasg.com/wp-content/uploads/2015/09/PTS_132.png
http://homasg.com/wp-content/uploads/2015/09/PTS_132.png
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− Preserve Luminosity (bảo toàn độ sáng) để các điều chỉnh không làm thay đổi 

độ sáng ban đầu của ảnh. Nếu bạn bỏ chọn, hình ảnh của bạn sẽ trông như được 

phủ thêm một lớp sáng mờ hoặc tối đậm. 

 

Ví dụ: Chỉnh lá cây xanh 

3.2 Lệnh Hue / Saturation (Ctrl + U) 

3.2.1 Preset 

− Dùng để hiệu chỉnh sắc độ, độ bão hòa màu và mức độ sáng tối cho hình ảnh. 

− Chọn các định dạng chuẩn (Preset) 

− Chỉnh sửa lại dựa trên mẫu chuẩn 

 

 

http://homasg.com/wp-content/uploads/2015/09/PTS_131.png
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Ví dụ: Chỉnh vùng ngọn tháp 

Sử dụng mẫu Sepia 

Điều chỉnh thông số một chút ở cả 3 kênh Hue, Saturation và Lightness để sáng 

hơn. 

 

3.2.2 Đặc tính thứ 1 Colorize 

− Tác động lên thanh bão hòa Saturation 

− Cách chỉnh: 

+ Bước 1: Click chọn icon  

+ Bước 2: Click chọn điểm màu muốn điều chỉnh trên ảnh (trong hình minh 

họa dưới đây, tôi chọn điểm màu xanh phổ biến trên hình), điểm màu bạn 

chọn sẽ được xác định trên 2 thanh điều hướng màu phía dưới hộp lệnh. 

+ Bước 3: Drag chuột qua lại những vùng màu xanh khác trên vòm lá cây, bạn 

sẽ thấy thông số trên thanh Saturation thay đổi. Thông số này càng lớn thì 

vùng khuếch tán gam màu xanh lá trên thanh điều hướng màu bên dưới sẽ 

càng rộng ra. Những tán cây trong hình ảnh càng xanh hơn 
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3.2.3 Đặc tính thứ 2  

− Tác động lên thanh màu sắc Hue 

− Cách chỉnh: 

+ Bước 1: Click chọn icon  

+ Bước 2: Nhấn giữ Ctrl và click chọn điểm màu cần chỉnh trên ảnh (trong 

minh họa dười đây, tôi chọn điểm màu vàng của những cái lá cây bị nắng rọi 

vào). 

+ Bước 3: Vẫn nhấn giữ phím Ctrl và drag chuột qua lại trên hình. 

Rê chuột qua trái, thông số trên thanh Hue cũng nghiêng về phía bên trái (số 

âm) 

 

Lưu ý:  
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Những thao tác này chỉ ảnh hưởng đến những vùng mang màu sắc của điểm 

màu mà bạn đã chọn ở bước 2, chứ không hề gây ảnh hưởng đến những vùng khác 

như bầu trời, tháp chùa… Điều này giúp khoanh vùng ảnh hưởng khá tốt. 

Đương nhiên là bạn có thể điều chỉnh 2 thanh còn lại : Lightness và Hue (Hoặc 

Saturation) để đạt được màu sắc như mong muốn. 

3.3 Lệnh Vibrance 

Hiệu chỉnh màu bằng cách cộng/ trừ dần từng màu, từng sắc độ sáng – tối. 

Kéo cả 2 thanh Vibrance và Saturation về bên phải (số dương —> tăng màu): màu 

sắc trong ảnh đậm và tươi hơn. 

  

Kéo cả 2 thanh về bên trái: ảnh màu có xu hướng bị chuyển thành ảnh trắng 

đen. 

3.4 Lệnh Exposure 

Exposure được thiết kế để hiệu chỉnh những hình ảnh dạng HDR (loại ảnh 

―siêu thực‖ có độ chênh lệch sáng tối rõ ràng, tự nhiên), nhưng nó chỉ làm việc với 

những hình ảnh 8 bit và 16 bit. 

Đặc biệt hữu dụng trong việc điều chỉnh những mảng hình ghép sao cho độ 

sáng tối khớp với nhau để trông tự nhiên hơn, đại loại như hình dưới đây, được 

ghép từ khá nhiều ảnh: 
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Cách thực hiện: 

 

− Chọn lệnh 

− Sử dụng 3 công cụ hút màu Eyedropper Tool ở bên phải với 3 cấp độ: điểm tối 

(đen), trung bình (xám) và sáng (trắng). Chọn từng công cụ rồi click điểm màu 

tương ứng trên hình 

− Chỉnh màu trực tiếp trên 3 thanh tùy chọn:  

+ Exposure (độ rực sáng, chỉnh cao quá thì những điểm sáng trên ảnh sẽ bị 

cháy sáng) 

+ Offset (bù màu, thông số > 0: ảnh như bị phủ 1 lớp trắng mờ, thông số < 0: 

màu sắc gom lại, đậm hơn) 

+ Gamma Correction (ngược lại với Offset, thông số > 1: màu tối đậm, còn < 

1 thì bị phủ trắng). 

 

− Preset cũng cung cấp cho bạn 4 tùy chọn có sẵn 

3.5  Lệnh Black & White (Alt + Shift + Ctrl + B) 

− Chuyển ảnh màu sang ảnh trắng đen một cách tự nhiên mà vẫn bảo toàn được 

tất cả các tính năng điều khiển cho riêng từng tông màu. 
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− Chọn ô Tint khi bạn muốn nhuộm cho toàn hình ảnh 1 màu tùy ý (click chọn 

màu trong ô vuông màu kế bên và sau đó dễ dàng điều chỉnh lại trên Hue và 

Saturation) 

Ví dụ:  ảnh bị thay đổi thành tông màu trông như cổ xưa. 

 

3.6 Photo Filter 

Giả lập kỹ thuật đưa bộ lọc màu vào trước ống kính camera để hiệu chỉnh mức 

độ cân bằng màu và nhiệt độ màu của đèn được truyền đến ống kính và chuyển 

thành phim hay hình ảnh.  

Lệnh Photo Filter còn cho phép chọn một màu sắc bất kỳ để cập nhật lên hình 

ảnh bằng cách sử dụng hộp màu color trong cửa sổ tùy chỉnh. 
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Lệnh này phủ lên hình ảnh 1 lớp màu để trông lạnh hơn hoặc nóng hơn. 

Chương trình cung cấp cho bạn một vài tùy chọn sẵn có trong mục Filter, hoặc 

bạn có thể chọn bất kỳ màu nào khác trong mục Color. 

Tăng / giảm sắc độ phủ màu trong Density và bảo tồn nguồn sáng của ảnh bằng 

cách kiểm chọn Preserve Luminosity (nếu tắt chọn, hình ảnh của bạn sẽ bị tối). 

3.7 Lệnh Color Lookup 

 

− 3DLUT file (loại hiệu ứng màu sắc thường dùng trong video và game), bạn có 

thể lấy màu từ những file có đuôi gốc *.CUBE trong máy nếu bạn có. (có thể 

download thêm trên mạng) 

− Abstract: bạn có thể dùng một vài tùy chọn có sẵn hoặc download thêm trên 

mạng các đuôi gốc *.ICC, *.ICM (loại file này thường dùng trong chế bản). 

− Device Link: giống như Abtract trên, chịu các đuôi gốc *.ICC, *.ICM. 

http://homasg.com/wp-content/uploads/2015/10/PTS_155.png
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Ví dụ: tùy chọn Device Link với chế độ Gold-Blue  

 

Tôi không muốn Gold_Blue nhuộm vàng bầu trời nên đã vào layer mặt nạ, 

dùng Brush che nhẹ một chút. Bạn có thể thấy những đường Brush đen trong 

review layer mặt nạ hình dưới đây. 

Nếu muốn tùy chỉnh nhiều hơn cho mặt nạ của Adjustments, bạn có thể click 

vào icon Mask ngay bên cạnh phải của icon Color Lookup để mở ra 1 mặt khác 

của palette. 

 

 

3.8 Lệnh Invert (Ctrl + I) 

Tạo âm bản cho hình ảnh. 

 

Ảnh thực càng sáng thì vào âm bản càng tối và có sự đảo ngược màu sắc. Mặt 

khác, âm bản cũng là hình ảnh phản xạ mà mắt chúng ta ghi nhớ được trong vài 

giây, sau đó thông qua phân tích của não bộ để tạo ra hình ảnh trong trí nhớ. 

Ví dụ:  hiệu ứng này để tạo ảnh kinh dị 
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3.9 Lệnh Posterize 

− Chỉ định thông số tông màu cho từng kênh. Lệnh Posterize chỉ định rõ cấp tông 

hoặc giá trị độ chói cho từng kênh trong hình ảnh, sau đó ánh xạ các pixel lên 

mức tương hợp gần nhất. 

 

− Mặc định Illustrator sẽ hạ xuống mức 4, hình ảnh được tối giản màu. Giảm 

xuống mức tối thiểu (mức 2) hình trông như pixel. Ảnh thông thường thường ở 

mức 33.  

− Đến mức 50 gần như bão hòa, bạn có tăng lên thì màu sắc cũng không thay đổi. 

Hiện tại thì rất ít ứng dụng dùng lệnh này. 

3.10 Lệnh Threshold 

− Chuyển hình ảnh sang màu đen trắng có độ tương phản cao đến mức biến thành 

ảnh pixel. 

− Mọi Pixel sáng hơn ngưỡng sẽ bị chuyển thành trắng, ngược lại, những Pixel 

sậm hơn ngưỡng sẽ bị chuyển thành đen. Ngưỡng ở đây được xác định là vùng 

màu trung bình, nên những vùng đồng dạng ngưỡng màu như bầu trời và biển 

trong hình dưới đây mặc định Threshold không thể phân định rõ. Muốn xác 

định rõ hơn cần phải di chuyển thanh trượt Threshold level đến mức cao nhất 

của đồ thị. 
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3.11 Lệnh Gradient Map 

− Phủ một lớp chuyển sắc lên hình ảnh được bắt theo độ đậm nhạt của hình. Vùng 

tối trong hình ảnh ánh xạ đến màu ở một đầu bên trái của mẫu tô, vùng sáng 

ánh xạ đến màu ở đầu bên phải của mẫu tô. 

 

− Đảo ngược màu thì kiểm chọn Reverse. Màu sắc tạo ra trông như âm bản vậy, 

bản thân tôi cũng không mấy thích thú với nó. 

− Dĩ nhiên, bạn có thể thay đổi màu chuyển sắc tùy ý. Nhưng thực tế cũng không 

có nhiều ứng dụng dùng lệnh này. 

3.12 Lệnh Selective Color 

− Hiệu chỉnh màu theo tông màu chọn. 
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− Chương trình sẽ cung cấp một số màu chọn trong mục Colors. Bạn muốn hiệu 

chỉnh tông nào thì chọn riêng tông đó; ở mỗi tông đều có thể tương tác 4 sắc 

Cyan  Magenta – Yellow – Black. 

− Nếu bạn muốn tác động chính xác lên các điểm màu mang tông chọn cụ thể thì 

kiểm chọn Absolute. Còn nếu muốn tác động tới các điểm màu tương tự tông 

được chọn trên toàn ảnh thì kiểm chọn Relative. 

 

3.13 Lệnh Shadow / Highlight 

− Giúp cải thiện chiều sâu của hình ảnh bằng cách hiệu chỉnh độ sáng / tối thích 

hợp dựa theo các pixel ở vùng phụ cận xung quanh vì thế Photoshop cho phép 

hiệu chỉnh các thông số thuộc tính của riêng biệt Shadow, Highlight và cả 

Adjustment. 

− Kiểm chọn Show more options để hiển thị toàn bộ tùy chọn. 

−  Mỗi kênh Shadows và Highlights đều có những mức Amount (vùng phủ sáng / 

tối) và Tonal Width (mức độ sáng / tối) riêng. Sự ảnh hưởng của Radius là rất 

yếu, gần như bằng 0 cho dù có tăng hay giảm nên bạn có thể không cần điều 

chỉnh. Cái hay của lệnh này là bạn có thể điều chỉnh riêng cho vùng tối hoặc 

sáng hoặc cả hai mà không có sự pha trộn tự động không mong muốn nào (nếu 

đừng đụng tới Adjustments bên dưới). 

http://homasg.com/wp-content/uploads/2015/10/PTS_167.png
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− Tại mục Adjustments, bạn có thể chỉnh màu của kênh Color Correction hoặc 

chỉnh độ tương phản của vùng sáng trung bình Midtone Contrast (cái này nên 

để mặc định hoặc tăng lên chứ không nên giảm, độ rõ nét sẽ bị ảnh hưởng). 

− Tăng / Giảm vùng ảnh hưởng tối tại Black Clip, vùng ảnh hưởng sáng tại White 

Clip.  

 

− Hình ảnh ban đầu thiếu sáng sau khi chỉnh, ảnh trở về mức sáng tối tự nhiên, 

không quá khoa trương, nhìn vào sẽ khó biết là có dùng Photoshop hay không. 
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BÀI 7: ĐIỀU CHỈNH HÌNH ẢNH    

Mã bài: MĐ18_07 

GIỚI THIỆU       

 Bài này giới thiệu với bạn về các bộ lọc trong menu Filter, mỗi bộ lọc có một 

ưu điểm riêng. Từ đó, bạn có thể áp dụng để chỉnh sửa ảnh hoặc tạo ra dạng ảnh 

nghệ thuật. 

MỤC TIÊU 

− Trình bày về chế độ màu được sử dụng trong Photoshop; 

− Thay đổi hình dạng ảnh tùy ý; 

− Trình bày  chức năng của các bộ lọc trong Photoshop; 

− Thay đổi được chế độ màu bất kỳ; 

− Tách, ghép được hình ảnh; 

− Sử dụng thành thạo các bộ lọc; 

− Có được tính sáng tạo, thẩm mỹ, linh hoạt, cách tổ chức khoa học. 

NỘI DUNG CHÍNH 

1 ĐIỀU CHỈNH HÌNH ẢNH 

1.1 Lệnh Duplicate 

Nhân đôi lớp 

− Layer/ Dulicate  

− Đặt tên cho lớp mới 

 

1.2 Lệnh Image size 

Thay đổi kích thước hình 
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1.3 Lệnh Canvas Size 

Tăng kích thước vùng làm việc 

− Menu Image/ Canvas Size 

− Chọn kích thước mới 

− Relative: Hiển thị kích thước hiện tại 

− Chọn màu: Tô phần mở rộng  

  

1.4 Lệnh Rotate Canvas 

− Xoay ảnh 
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2 CÁC BỘ LỌC  

2.1 Bộ lọc Artistic 

Bộ lọc có tác dụng tô vẽ cho ảnh, chuyển ảnh sang dạng ảnh vẽ chì, ảnh vẽ 

bằng màu nước 

− Pencil  

− Cutout   

− Watercolor  

2.2 Bộ lọc Blur 
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Bộ lọc làm mờ, nhoè ảnh 

− Filter> Blur> Blur Gassian  

− Filter> Blur> Motion Blur  

− Filter> Blur> Radial Blur  

 

Filter> Blur> Smart Blur  

2.3 Bộ lọc Brush Stroke 

Hiệu ứng trên đường viền  

− Accented Edges: Tác động lên đường viền 

+ Edge Width: độ dày của đường viền 

+ Brightness: độ sáng của đg viền 

+ Smoothness: độ sắc nét của đường viền 

− Angled Strokes: chuyển ảnh sang dạng nét chì 
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− Crosshatch: 

− Dark Strokes: 

− Ink Outline: 

− … 

  

− Filter> Brush Strokes> Accented Edges  

 

2.4 Bộ lọc Distort 

− Filter> Distort > Pinch  

 

− Filter> Distort > Shear  
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− Filter > Distort > Spherize  

 

2.5 Bộ lọc Noise 

 

− Filter > Noise > Add Noise  

− Filter > Noise > Reduce Noise  

 

2.6 Bộ lọc render 

− Filter> Render> Clouds  

− Filter > Render > Difference Clouds  
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− Filter> Render> Lens Flare  

2.7 Bộ lọc Sharpen 

− Công dụng của nó dùng để điều chỉnh độ tương phản của những tiểu tiết và tạo 

cho người xem có cảm giác bức ảnh sắc nét trên từng chi tiết nhỏ. 

+ Amount : độ nét 

+ Threshold. tác dụng xác định những đơn vị pixel được làm sắc nét sẽ phải 

khác biệt với những vùng xunh quanh đó như thế nào trước khi nó được coi 

là những đơn vị pixel đường viền và cuối cùng được làm sắc nét bởi bộ lọc 

Unsharp Mask 

+ Radius để xác định số Px bao quanh viền, những Px này sẽ tác động đến 

Sharpening. Độ phân giải càng cao, thì giá trị Radius cũng nên để cao. 

2.8 Bộ lọc Shektch 

 

− Filter > Sketch > Bas Relief  

− Filter > Sketch > Reticulation  
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− Filter > Sketch > Graphic Pen  

  

2.9 Bộ lọc Stylize 

− Filter > Stylize > Extrude  

− Filter > Stylize > Find Edges  

2.10 Bộ lọc Texture 

− Filter > Texture > Patchwork  

− Filter > Texture > Stained Glass  
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− Filter > Texture > Texturizer  

2.11 Bộ lọc Pixelate 

− Filter > Pixelate > Color Halftone  

− Filter > Pixelate > Crystalize  

− Filter > Pixelate > Mosaic  

− Filter > Pixelate > Pointilize  

2.12 Bộ lọc Other 
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− Filter > Other > Maximum  

− Filter > Other > Minimum  
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BÀI 8: CÁC KỸ THUẬT NÂNG CAO  

Mã bài: MĐ18_08 

GIỚI THIỆU 

Bài này hướng dẫn bạn sử dụng kỹ thuật Clipping Mash để lồng ảnh với nhau 

MỤC TIÊU 

− Trình bày các loại mặt nạ trong Photoshop; 

− Sử dụng được các lớp có sẵn, điều chỉnh lớp; 

− Tạo và sử dụng mặt nạ thành thạo; 

− Có được tính sáng tạo, thẩm mỹ 

NỘI DUNG CHÍNH 

1 LAYER MASKS 

− Layer mask là layer mặt nạ dùng để che đi một phần của layer dưới nó. 

− Layer này có 2 màu chính: đên, trắng 

− Phần màu đên là phần sẽ bị che đi  

 

Ví dụ: 
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2 Tạo Layer Mask 

− Để tạo một mask có màu trắng, bạn bấm chuột vào biểu tượng Add layer 

mask  trên Layers panel (hoặc chọn Layer > Layer Mask > Reveal All) 

 

− Để tạo một mask có màu đen, bạn nhấn giữ phím Alt và bấm chuột vào biểu 

tượng Add layer mask  trên Layers panel (hoặc chọn Layer > Layer 

Mask > Hide All). 

 

− Tạo Layer Mask từ vùng chọn.  
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+ Add layer mask  trên Layers panel.  

+ Layer > Layer Mask > Reveal Selection. 

 

− Giả sử bạn đã có một vùng chọn trên layer. Nếu muốn giữ lại phần hình ảnh 

bên ngoài vùng chọn và làm cho phần hình ảnh bên trong vùng chọn của layer 

trở thành trong suốt, bạn nhấn giữ phím Alt và bấm chọn biểu tượng Add layer 

mask  trên Layers panel. Hoặc bạn cũng có thể chọn Layer > Layer Mask 

>  Hide Selection. 

− Tắt tác dụng của layer mask bạn chọn  

+ Layer > Layer Mask > Disable 

+  Layer > Layer Mask > Enable để layer mask có tác dụng trở lại. 
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− Để xóa Layer mask ta kéo thumbnail của mask vào biểu tượng  trên Layers 

panel 

3 Hiệu chỉnh mask 

− Bạn cần chú ý xác định rõ Layer mask trước khi thực hiện  

− Khi đã chọn thao tác với mask, tùy theo mục đích bạn có thể dùng công cụ tô vẽ 

như:    Brush , Clone Stamp , Eraser , Pencil , Gradient , 

Paint Bucket ... để tô vẽ lên mask. 

+ Phần được tô màu trắng sẽ hiển thị  

+ Phần tô màu khác sẽ hiển thị mờ hoặc không hiển thị 

 

4 Tạo layer masks từ những đường work path 
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Mask cũng có thể là các dạng hình học được tạo ra từ các công cụ tạo Shape 

bằng cách vào Layer / Add Vector Masks / Reveal(hide) All. 

 

5 Sử dụng nhiều Mask 

Ta có thể áp dụng nhiều Mask cùng lúc. Tuy nhiên trong mỗi một thời điểm chỉ 

có thể sử dụng 1 Mask mà thôi Mask nào ở phía trước được áp dụng mask ở phía 

sau muốn được áp dụng phải "disable" Mask ở trước . Tuy nhiên nếu có Vector 

Mask thì Vector Mask sẽ được ưu tiên áp dụng.  

Vi dụ minh họa sử dụng Mask và Vector Mask cùng lúc 

 

Ví dụ minh họa Disable Mask phía trước và phía sau 

 



 

94 

 

6 Để kết hợp nhiều Mask 

Muốn sử dụng nhiều Mask (không có Vector Mask) thì ta dùng Layer Group. 

Chọn Layer nhấn tổ hợp Ctrl+G để tạo Layer Group sau đó áp dụng Mask lên 

Group. 

 

7 Clipping mask 

Clipping mask là kỹ thuật tạo ra mặt nạ, cắt đi phần được chỉ định loại bỏ.  

Ví dụ: Chúng ta sẽ thay thế tròng kính bằng một hình ảnh phản chiếu thông qua 

Clipping mask. 
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Kết quả: 

 

Bước1. Sử dụng công cụ Lasso (L) để cắt tròng kính: 

Bước 2. Tạo layer mới 
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Bước 3. Fill vùng chọn màu đen (Alt+Detele) 

Bước 4. Dùng công cụ Move (V) để kéo ảnh 2 sang ảnh 1. 

 

Bạn sắp sếp thứ tự layer như thế này 

 

Bước 5. Tạo Clipping Mask 

Khi layer trên cùng đang active, bạn chọn Layer > Creat Clipping Mask hoặc 

nhấn tổ hợp phím Ctr+Alt+G. Kết quả: 
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Trong palette layer bạn thấy layer trên xuất hiện mủi tên trỏ xuống, cho thấy nó 

đang kết hợp clipping mask với layer dưới. 

Bước 6. Thay đổi kích thước ảnh phản chiếu cho phù hợp với góc nhìn (Ctr+T) 

   

Bước 7. Tạo Inner shadow 

Hình cắt quá sắc nét, bạn tạo đổ bóng để thất sự hòa hợp giữa hình và khung 

kính 

Chọn layer thứ hai, bấm chọn vào biểu tượng Layer Style 

  

Chọn Inner Shadow từ menu  

Các thông số: Blend: Multifly; Angle: 65; Distance: 1; Size: 3 
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8 Adjustment layer 

Adjustment Layers trong Photoshop là một nhóm rất hữu ích, các công cụ 

chỉnh sửa ảnh không phá hủy thêm màu sắc và hiệu chỉnh hỉnh ảnh của bạn rõ 

ràng, sắc nét mà không cần thay đổi pixel. Với các lớp điều chỉnh (Adjustment 

Layers), bạn có thể chỉnh sửa và loại bỏ hoặc khôi phục lại hình ảnh ban đầu của 

bạn bất cứ lúc nào. Điều này sẽ làm cho việc của bạn trong khi học Photoshop linh 

hoạt và hiệu quả.  

Adjustment Layers là công cụ chỉnh sửa màu ảnh để làm sáng rõ đường nét 

trong bức ảnh. Khi bạn muốn thêm một Adjustment layer để cho ảnh của bạn, một 

layer mới sẽ xuất hiện trên các bức ảnh của bạn và một bảng điều tiết cụ thể cho 

các loại điều chỉnh mà bạn đã chọn sẽ bật lên. Bảng Properties sẽ cho phép bạn 

chỉnh sửa các lớp điều chỉnh của bạn, do đó sẽ làm thay đổi hình ảnh của bạn. 

 

https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers-1.png
https://hocphotoshop.vn/khoa-hoc-photoshop-co-ban-nang-cao-o-ha-noi.html
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− Khi bạn muốn thêm một Adjustment layer để cho ảnh của bạn, một layer mới sẽ 

xuất hiện trên các bức ảnh của bạn và một bảng điều tiết cụ thể cho các loại 

điều chỉnh mà bạn đã chọn sẽ bật lên. Bảng Properties sẽ cho phép bạn chỉnh 

sửa các lớp điều chỉnh của bạn, do đó sẽ làm thay đổi hình ảnh của bạn. 

8.1 Brightness/Contrast 

 

Brightness/Contrast là làm cho điều chỉnh để các dải âm của hình ảnh của bạn. 

Thanh trượt độ sáng là để điều chỉnh những điểm nổi bật trong hình ảnh của bạn và 

các thanh trượt để điều chỉnh độ tương phản là bóng tối trong hình ảnh của bạn. 

8.2 Levels  

Levels là định nghĩa một giá trị trong bức ảnh sử dụng adjustment với 

phần shodows, midtones, và highlights. Đó là một trong những công cụ được sử 

dụng nhất trong việc điều chỉnh bảng layer, và chỉ sử dụng một liên lạc của các cấp 

sẽ đi một chặng đường dài trong việc điều chỉnh hình ảnh của bạn. 

https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers2.png
https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers2.png
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8.3 Curves 

 

https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers3.png
https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers4.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers3.png
https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers4.jpg
https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers3.png
https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers4.jpg
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Curves điều chỉnh như nhiều điểm như bạn muốn trong suốt toàn bộ dải âm của 

hình ảnh của bạn, và là công cụ mạnh mẽ nhất và chính xác để chỉnh sửa các tông 

màu trong ảnh. Khi bạn nhấn chuột vào việc điều chỉnh đường cong, một đường 

chéo trên một đồ thị xuất hiện (bên trái) đại diện cho dải âm của hình ảnh. Trục x 

đại diện cho các giá trị ban đầu trong hình ảnh, trong khi trục y đại diện cho các 

giá trị điều chỉnh mới.  

Để nâng cao chất lượng tổng thể và độ tương phản của hình ảnh của bạn, nhấp 

vào để thêm điểm trên dòng của đồ thị của bạn. Một khi bạn đã thêm một điểm, 

bạn có thể kéo điểm lên hoặc xuống với con chuột của bạn. Kéo điểm xuống làm 

tối hình ảnh của bạn, kéo điểm lên làm sáng nó. Những gì tôi đã làm ở trên là thêm 

hai điểm để đồ thị của tôi, kéo lên để tăng cường những điểm nổi bật, và rút xuống 

để tăng cường bóng tối trong hình ảnh, tạo ra một chút ―S‖ đường cong. Đây chỉ là 

những điều cơ bản, nhưng ngay cả những ứng dụng đơn giản nhất của các công cụ 

đường cong có thể cải thiện hình ảnh của bạn. 

8.4 Exposure 

Exposure Cho phép bạn điều chỉnh mức độ tiếp xúc với ba thanh 

trượt: Exposure, Offset và Gamma. Tiếp xúc sẽ chỉ điều chỉnh những điểm nổi bật 

của hình ảnh, Offset điều chỉnh âm trung và Gamma sẽ điều chỉnh tông màu tối . 

 

 

8.5 Vibrance 

https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers5.png
https://hocphotoshop.vn/wp-content/uploads/2015/08/Adjustment-Layers5.png
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Vibrance là lớp điều chỉnh này sửa đổi các rung động của một hình ảnh trong 

hai cách. Thanh trượt Saturation slider đều làm tăng độ bão hòa của tất cả các màu 

sắc trong hình ảnh. Thanh trượt Vibrance slider đổi mức độ bão hòa của tất cả các 

màu sắc quá, nhưng có chọn lọc hơn, tập trung vào các màu sắc bão hòa và ít nhất 

là tránh qua bão hòa của màu da. 

8.6 Hue/Saturation 
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Hue/Saturation cho phép bạn điều chỉnh màu sắc, độ bão hòa và nhẹ nhàng của 

toàn bộ hình ảnh của bạn hoặc trong một phạm vi cụ thể của màu sắc trong hình 

ảnh của bạn. 

Trong ví dụ đầu tiên, tôi đã điều chỉnh các thanh trượt để tăng độ bão hòa của 

toàn bộ hình ảnh. Trong ví dụ thứ hai, tôi nhấp vào ―Preset‖ trình đơn thả xuống, 

trong đó đã cho tôi lựa chọn để chọn ―Greens.‖ Tôi chọn màu xanh vì tôi muốn 

làm giảm độ bão hòa của chỉ màu xanh trong hình ảnh của tôi để làm cho nó dễ 

dàng hơn trên đôi mắt. 

Nó thường là tốt hơn để không ảnh hưởng đến độ bão hòa trên toàn bộ hình 

ảnh – làm này làm giảm phạm vi âm tổng thể. Thay vì cố gắng ảnh hưởng đến sự 

bão hòa của màu sắc cụ thể trong hình ảnh của bạn để kiểm soát tốt hơn chỉnh sửa 

hình ảnh của bạn. Công cụ này cũng tốt cho colorizing màu xám. 

8.7 Color Balance 
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Color Balance thay đổi hỗn hợp của màu sắc trong ảnh. Trong ví dụ này, tôi đã 

thực hiện một lựa chọn duy nhất đôi cánh của con bướm và điều chỉnh các thanh 

trượt màu sắc nhằm mang lại màu đỏ và magentas trong đôi cánh của nó. 

8.8 Balck & White 

Balck & White cho phép bạn thực hiện các phiên bản màu xám của hình ảnh 

của bạn. Những hình ảnh bên trái là các thiết lập mặc định. Trong ảnh bên phải tôi 

đã thay đổi cài đặt sẵn để ―Custom‖ điều chỉnh thanh trượt để tôi có kiểm soát 

nhiều hơn như thế nào là màu đỏ trong cánh của ruồi bơ của tôi đã được chuyển 

đổi sang màu đen và trắng. 

 

8.9  Photo Filter 
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Photo Filter thêm đầy đủ màu sắc khác nhau lên bức ảnh. Đối cới 2 ví dụ trên 

trong ảnh thì hộp ―Preserve Luminosity‖ là được kiểm tra mặc định và được điều 

chỉnh thanh ―Density‖ để tăng cường hiệu quả các bộ lọc. Bạn cũng có thể tùy 

chỉnh từng bộ lọc màu bằng cách nhấp đúp vào bảng màu trong bảng thuộc tính để 

điều chỉnh nó trong cửa sổ Color Picket. 

8.10 Channel Mixer 

 

Channel Mixer định nghĩa màu trong ảnh để tạo ra hình ảnh nhuộm màu hoặc 

màu xám. Bên phải chúng ta đã sử dụng các kênh màu đỏ để mang lại một màu đỏ 

trong hình ảnh. Ở bên trái, chúng tôi đã kiểm tra các ―Monochrome– đơn sắc‖ hộp 

và điều chỉnh các thanh trượt để đảm bảo một sự chuyển đổi màu sắc tốt hơn để 

màu xám. Để có kết quả tốt nhất với công cụ này, hãy chắc chắn rằng các kênh của 

bạn thêm đến 100%. 

8.11 Color Lookup 
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Điều chỉnh này đi kèm một loạt các đóng gói sẵn để bạn có thể áp dụng đối với 

hình ảnh của bạn. Có 3 lựa chọn (3DLUT File, Abstract, và Device Link) được sử 

dụng để tải các hình ảnh khác nhau. Mỗi hình ảnh lại vẽ lại các màu sắc trong hình 

ảnh của bạn bằng cách sử dụng một bảng tra cứu (LUT). Những hiệu ứng này rất 

hay và thậm chí bạn có thể tạo LUTs của riêng bạn trong Aobe Speedgrade và nạp 

vào trong Photoshop phù hợp với phong cách của bạn. 

 

 

 

8.11.1 Invert 
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Invert adjustment layer tạo một hiệu ứng ảnh bằng cách đảo ngược màu sắc 

hình ảnh của bạn 

8.12 Posterize 

Posterize cung cấp một flat, poster như với một hình ảnh giảm số lượng độ 

sáng trong hình.. 

 

8.13 Threshhold 

 

Threshhold trả lại trong ảnh với gam màu trắng và đen. Với ví dụ này, tạo nên 

một ngưỡng chỉ phù hợp với hình bông hoa trong ảnh. Tăng và giảm ngưỡng kiểm 

soát số lượng điểm ảnh chuyển màu trắng hoặc đen. 

8.14 Gradient Map 
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Công cụ này chuyển đổi các dải màu xám của một hình ảnh đến một điền tùy 

chỉnh gradient. Các công cụ Gradient Map đi kèm với một loạt các gradient khác 

nhau, tất cả trong số đó bạn có thể điều chỉnh theo ý thích của bạn trong cửa sổ 

soạn thảo gradient. Kiểm tra hộp ―Reverse‖ đảo ngược màu của gradient của bạn. 

8.15 Selective Color 

 

− Lớp điều chỉnh Selective Color chọn lọc đổi số của một màu cơ bản mà không 

sửa đổi các màu cơ bản khác trong hình ảnh của bạn. Từ khi có rất nhiều màu 

đỏ trong bức ảnh hoa, chọn màu đỏ từ trình đơn ―Color‖ thả xuống như màu sắc 

trong bức ảnh mà bạn muốn chọn và thay đổi. Theo mặc định ―Absolute‖ được 

chọn trong CS6, có thể điều chỉnh màu sắc trong các giá trị tuyệt đối. (Các tùy 

chọn ―Relative‖ thay đổi số tiền hiện có của màu lục lam, đỏ tươi, màu vàng 

hoặc màu đen bằng tỷ lệ phần trăm của tổng số.) 

− Tiếp theo, tôi đã kéo các thanh trượt xung quanh trong bảng tính tăng và giảm 

các thành phần trong các màu đỏ trong hình ảnh. Kết quả là, tôi đã chọn lọc 

thay đổi các màu đỏ trong các bức ảnh mà không thay đổi các phụ trong bức 

ảnh. Đó là một công cụ chính xác hơn cho việc thay đổi màu sắc cụ thể 

hơn Hue/Saturation và nó thường được sử dụng để điều chỉnh tông màu da 

trong ảnh. 
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− Những ví dụ này chỉ có một nhiệm vụ nhỏ của mỗi công cụ trong các lớp điều 

chỉnh có thể làm, tất cả chúng đều có khả năng làm những việc khác nhiều hơn. 

Trên đây chỉ là cơ bản để giới thiệu công cụ với người mới học photoshop, 

dùng kỹ thuật chỉnh sửa không phá hủy này của lớp điều chỉnh sẽ cải thiện công 

việc của bạn và làm cho toàn bộ kinh nghiệm Photoshop của bạn dễ dàng hơn 

rất nhiều. 
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BÀI TẬP 

1 Bài tập sử dụng công cụ vẽ cơ bản 

 

2 Công cụ Selection trong 

Bài 1: Ghép 2 hình  để được hình kết quả sau: 
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3 Công cụ tạo vùng  chọn (quick mask, layer mask, clipping mask, pen) 

  

4 Công cụ Text 

 
 



 

113 

5 Công cụ Transform 

 

 
 

6 Công cụ Spot Healing Brush, Healing Brush, Patch xóa các vật thể trong 

hình 
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7 Công cụ Dodge, Sponge tăng màu đậm nhạt 

 

8 công cụ Fill Color và Fill Gradient đổi màu hình 

      
 

 



 

115 

9 Sử dụng bảngd điều khiển Layer Style tạo nút nhấn 

 

 

10 Bài tập tạo pattern 

 

 

11 Bài tập tạo wallpaper 
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12 Bài tập cát ghép ảnh 

 

 

13 Bài tập làm mịn da 
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14 Bài tập tô vẽ thêm cho ảnh màu 

   

15 Bài tập chỉnh sáng tối 

    

16 Bài tập đổi màu 
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17 Bài tập tạo hiệu ứng cho hình 

  

18 Bài tập thiết kế web 
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